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Disclaimer and Limitation of Liabili
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that the information within it was correct at the time of publication, the publishers and the
authors do not assume and hereby disclaim any liability to any party for any loss or damage
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SPECIFICALLY DISCLAIM THE IMPLIED WARRANTIES OF TITLE, NON-
INFRINGEMENT, MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. THERE IS NO WARRANTY OR GUARANTEE THAT THE OPERATION
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FREE, OR THAT THE INFORMATION WILL MEET ANY PARTICULAR
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LIMITATION, TORT, CONTRACT, OR STRICT PRODUCTS LIABILITY, SHALL
TRAIN SIGNAL, INC. OR ANY OF ITS SUPPLIERS BE LIABLE TO YOU OR ANY
OTHER PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR
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DAMAGES IN EXCESS OF TRAIN SIGNAL, INC.S LIST PRICE FOR THE
INFORMATION.

To the extent that this Limitation is inconsistent with the locality where You use the
Software, the Limitation shall be deemed to be modified consistent with such local law.

Choice of Law:

You agree that any and all claims, suits or other disputes arising from your use of the
Information shall be determined in accordance with the laws of the State of Illinois, in the
event Train Signal, Inc. is made a party thereto. You agree to submit to the jurisdiction of
the state and federal courts in Cook County, Illinois for all actions, whether in contract or in
tort, arising from your use or purchase of the Information.
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Introduction

Welcome to Train Signal!

This series of labs on Windows 2000/2003 is designed to give you detailed, hands-on
expetience working with Windows 2000/2003. Train Signal’s Audio-Visual Lab coutses are
targeted towards the serious learner, those who want to know more than just the answers to
the test questions. We have gone to great lengths to make this series appealing to both those
who are seeking Microsoft certification and to those who want an excellent overall
knowledge of Windows 2000/2003.

Each of our courses puts you in the driver’s seat, working for different fictitious companies,
deploying complex configurations and then modifying them as your company grows. They
are not designed to be a “cookbook lab,” where you follow the steps of the “recipe” until
you have completed the lab and have learned nothing. Instead, we recommend that you
perform each step and then analyze the results of your actions in detail.

To complete these labs yourself, you will need at least three computers equipped as
described in the Lab Setup section. You also need to have a foundation in Windows 2000
and TCP/IP concepts. You should be comfortable with installing Windows 2000
Professional or Server and getting the basic operating system up and running. Each of the
labs in this series will start from a default installation of Windows 2000 and will then run you
through the basic configurations and settings that you must use for the labs to be successful.
It is very important that you follow these guidelines exactly, in order to get the best results
from this course.

The course also includes a CD-ROM that features an audio-visual walk-through of all of the
labs in the course. In the walk-through, you will be shown all of the details from start to
finish on each step, for every lab in the course. During the instruction, you will also benefit
from live training that discusses the current topic in great detail, making you aware of many
of the associated fine points.

Thank you for choosing Train Signall

Page 7 of 112 © Train Signal, Inc., 2002-2003
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Setting up the Lab

1. Computer Equipment Needed

Item Minimum Recommended

Computers (3) Pentium I 133 MHz (4) Pentium II 300MHz or greater
-a 4" system is needed for Lab 4 only

Memory 128 MB 256 MB
Hard Drive 2GB 4 GB or larger
NIC 1/machine (2 computers) 1/machine (2computers)

2 for the VPN server machine | 2/VPN server (2 computers)

Hubs 2 2 (3 are needed for Lab 4)

Network Cable | (4) Category 5 cables (5) Category 5 cables

I strongly urge you to acquire all of the recommended equipment in the list above. It can all
be easily purchased from eBay or another source, for around $400 (less if you already have
some of the equipment). This same equipment is used over and over again in all of Train
Signal’s labs and will also work great in all sorts of other network configurations that you
may want to set up in the future. It will be an excellent investment in your education. You
may also want to look into a disk-imaging product such as Norton Ghost. Disk imaging
software will save you a tremendous amount of time when it comes to reinstalling Windows
2000 for future labs. Many vendors offer trial versions or personal versions of their
products that are very inexpensive.

Page 10 of 112 © Train Signal, Inc., 2002-2003
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2. Computer Configuration Overview

Computer 1 2 3
Number
Computer Name SRV-1 Client-1 SRV-11
IP Address NIC #1 192.168.1.201/24 15.15.15.20/8 | 192.168.1.1/24

NIC #2 15.15.15.15/8

Default Gateway N/A 15.15.15.15 192.168.1.201
OS W2K Server W2K Pro W2K Server
Additional SP2 SpP2 SP2
Contfigurations

3. Detailed Lab Configuration

***Important Note***

This lab should NOT be performed on a live production network. You should only use computer
equipment that is not part of a business network AND is not connected to a business network.
Train Signal Inc. is not responsible for any damages. Refer to the full disclaimer and limitation of
liability, which appears at the beginning of this documentand onour Website at:
http://www.trainsignal.com/legalinfo.html

Page 11 of 112 © Train Signal, Inc., 2002-2003
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Computer 1

Computer 1 will be named SRV-1 and the operating system on this computer will be
Windows 2000 Server or Advanced Server. You should also install Service Pack 2 to avoid
any unforeseen problems. If you do not have a copy of Windows 2000 Server you can
obtain an evaluation copy of Windows 2000 Advanced Server within the Microsoft Press
seties of books, and Service Pack 2 is available for download on Microsoft’s Website.

SRV-1 will have 2 network cards, each with a static IP address. One NIC will have an IP
address of 192.168.1.201, with a 255.255.255.0 subnet mask and it should be renamed as
private. The default gateway can be left blank. Configure the preferred DNS server setting
to point to SRV-11, 192.168.1.1, and leave the alternate DNS setting blank. The second
NIC will have an IP address of 15.15.15.15 with a 255.0.0.0 subnet mask. This NIC should
be named public. The default gateway field and the DNS Server field should be left blank.
You will need to make this computer a member server of the greenlizardbooks.com domain,
by simply right clicking on the “My Computer” icon on the desktop and selecting
Properties. Select the Network identification tab, select Properties, select domain and
type in the domain name of the domain it will join, which is greenlizardbooks.com or its
NetBIOS name, greenlizardbook. Note: NetBIOS names are a single label (no periods) up
to 15 characters in length. Then click OK. Windows 2000 will then ask for a username and
password. Use the administrator account name and password from the
greenlizardbooks.com domain. When it has joined successfully, it will “welcome you to
the domain” and then tell you that it needs to restart in order for the changes to take effect.
After restarting the computer, make sure you change the “Log on to” dialog box to the
domain rather than “this computer”. See figure 1, next page.

***Important Note***
This last step (joining SRV-1 to the domain) cannot be performed until after you have created the
greenlizard.com domain by running depromo on SRV-11 in the Computer 3 setup below.

Computer 2

Computer 2 will be named Client-1 and Windows 2000 Professional will be installed on this
computer along with Service Pack 2. Client-1 will be joined to the greenlizardbooks.com
domain. Client-1 will eventually be a VPN client, but initially will have a static IP address of
15.15.15.20 with a 255.0.0.0 subnet mask. The default gateway should be configured to
point to SRV-1, 15.15.15.15, and the DNS Server field should be left blank. See figure 1,
next page.

Computer 3

Computer 3 will be named SRV-11 and will have Windows 2000 Server or Advanced Server
installed as the operating system. SRV-11 will have a static IP address of 192.168.1.1 with a
255.255.255.0 subnet mask. The default gateway should be configured to point to SRV-1,
192.168.1.201, and the DNS server field should be left blank. See figure 1, next page.

Page 12 of 112 © Train Signal, Inc., 2002-2003
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SRV-11 will be setup as the domain controller for Green Lizard Books Inc., called
greenlizardbooks.com by using the dcpromo.exe program. In order to make this machine a
domain controller, DNS will need to be installed as well. There are 2 ways to install DNS —
automatically when you run dcpromo.exe or manually when you install it through
Add/Remove Programs in Control Panel. For our purposes, we are going to install DNS
automatically. To run depromo.exe on this machine go to the desktop, click on Start =
Run, then type in DCPROMO in the run command and click OK. Make the following
selections as you are prompted: Domain controller for a new domain; Create a new
domain tree; Create a new forest of domain trees. The DNS domain name for the
scenario is greenlizardbooks.com. The NetBIOS name will be greenlizardbook. Notice that
there is no “s” at the end of greenlizardbook. This is because NetBIOS names can be a
maximum of 15 characters long and the “s” would have been the 16" character. Leave all
the other settings at their defaults. When the wizard asks if you would like to install and
configure DNS on this computer, select Yes, install and configure DNS on this
computer. Also choose permissions compatible with pre-Windows 2000 servers. In the
next step, you will be asked for an AD password - for our purposes, we will leave this blank.
Active Directory installation should then take place and you can restart the computer when
you are prompted. MAKE SURE that the network card is plugged into a hub or into
another computer with a crossover cable before you run dcpromo. Otherwise, Active
Directory installation will fail, without giving you a clear cause. See figure 1.

Important - You should test the network connections (using the PING command) between
each of these machines to ensure that your network is set up propetly. Testing before you
get started will save you major time and effort later.

Remote Access |

Lab Setup

Static IP: J Static IP:
- 192.168.1.201/24 15.15.15.15/8

- z Computer Mame: Srne-1 Computer Mame: Client-T
Computer Mame: Sre-171
Statisll-lP'lrsz 168 ‘.'wf.-"24 OS: WaK ServerSP2 Static IP; 15.15.15.20/8
Default Gateway: 192 168, 1.201/24 Services: Defaull Gateway: 15.75.15. 15/8
OS: Wak ServerrSP2 VPN 05 W2K Professional/SE2
Sarvicas:
Devrraln Cantrollar
DNS

(figure 1)

***Important Note***

This lab should NOT be performed on a live production network. You should only use computer
equipment that is not part of a business network AND that is not connected to a business network.
Train Signal Inc. is not responsible for any damages. Refer to the full disclaimer and limitation of
liability which appears at the beginning of this document and on our web site, www.trainsignal.com
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LLab 1

Setting up a Virtual Private Network for
Green Lizard Books, Inc.

You will learn how to:

e Install a VPN Server using the RRAS setup wizard
e Manually configure a VPN Server
e LExamine and Configure the properties of a VPN Server
e Setup a VPN client and configure its properties

e Test the VPN Server using different tunneling protocols
e Test the VPN Server using different authentication protocols

Page 15 of 112 © Train Signal, Inc., 2002-2003
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Scenario

Green Lizard Books Inc. is a book publishing company located in Chicago, IL. Green
Lizard deals with authors, publishers and retail stores throughout the US and sometimes
internationally. While traveling, Green Lizard executives and sales representatives must be
able to use the company’s private network in order to access contracts, sales leads and the
customer database. Green Lizard is currently using a dial-up remote access solution to
provide access to their employees. This solution has worked adequately for several years,
but lately it has proven to be unreliable. In addition, it has always been slow and the
monthly long distance expenses have been substantial, due to employees dialing in from
locations that are not local to Chicago. The owner, Bill, is looking for a more reliable
solution that will reduce the current long distance expense. You have been hired as an
independent computer consultant to assist Green Lizard in finding a replacement to their
current dial-up solution.

Since Green Lizard already has a dedicated connection (T'1, operating at 1.5 Mbps) to the
Internet, you suggest that they should consider deploying a Virtual Private Network (VPN).
You inform him that a VPN would be an ideal remote access solution for his current
situation.  “A VPN,” you explain, “will allow Green Lizard’s employees to access the
company network utilizing a secure connection over the Internet. Users will simply need to
dial into a local ISP first, in order to connect to the company LAN. This will tremendously
reduce the cost of long distance charges due to remote access connections.” Bill likes your
idea and wants you to start on it immediately.

In this lab, you will install a VPN Server using both the RRAS wizard and manual setup for
Green Lizard Books Inc. You will then configure the VPN Server’s properties and modify
its available port settings. You will also set up a VPN client and test the VPN connection.
Finally, you will test the VPN connection using L2TP and different remote authentication
protocols.

Page 16 of 112 © Train Signal, Inc., 2002-2003
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Green Lizard Books Inc.J

Current Environment

Remote Access
Sarver

Router

Client Computers

Remoate Computer

Internet

T1 Conrectivity

Windows 2000 Remote Access Solutions

VPN connections vs. Dial-up connections

VPN connections

Dial-up connections

Connection Methods

VPN client establishes a local
connection to the Internet and
connects to the LAN through a
VPN server. This connection
provides secure remote access

through the Internet over a
TCP/IP connection.

Dial-up client uses common phone
lines over the Public Switched
Telephone Network (PSTN) to
create a physical connection to a
modem on a remote access server
on the company LAN.

Requires remote clients to
connect to the Internet through
a local Internet service provider

Requires expensive long-distance
telephone charges or toll calls if
there is a large number of remote

Cost (ISP) only. It can reduce long- | clients traveling to far away
distance telephone charges and | locations.
toll calls.

Telecommunication/ | Requires an existing connection | Requires many incoming telephone

Hardware requirement

to the Internet and a VPN
server on the LAN

lines and hardware devices in-
house (such as remote access
servers, modem pools, etc.)
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Green Lizard Books Inc. J

After VPN upgrade

WPN tunnel

Internet

Router

Remate Computer

Client Computers

Green Lizard Books Inc.J

Clierft-1
ient in this lab)

Hub or Switch
(Acts as the Internet)

Private LAN

with VPN server

Domain Controller
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Creating a share to test remote access

Before you install the VPN Server, you will create a file in a shared folder on the domain
controller, SRV-11. This file will be used to test access from Client-1, your VPN client, to
the internal network through the VPN Server.

1. Log on to SRV-11, open Windows Explorer, and then open the C: drive. Create a new
folder named Sales Reports. This can be done by right clicking on an empty space
within the C: drive and selecting New Folder from the shortcut menu. You should now
have a folder in the C: drive named Sales Reports. Close Windows Explorer when you
are finished.

T DO 0O 0O ;.

b H =
- Documents  Program Files WINMT Sales Reports
Local Disk (C:) and Settings N

Sales Reports
File Folder

Modified: &8/6/2003 5:14 PM

Aktributes; {normal)

2. Next, use Notepad to create a simple text file that will be stored within the Sales Reports
folder. Go to Start>Programs—>Accessories—> Notepad.

Accessibility

@ Communications

@ Entertainment

@ Games

Microsoft Script Debugger
@ System Tools

Address Book

Calculator

B command Prompt

E Imaging
B paint

@ Synchronize
@ Windows Explorer
@ WordPad

* v v v v v

3. In Notepad, type in Sales Report 03 and then select File=>Save As from the menu.

_Ioix]

File Edit Formak Help
Sales report 03 -

4 b o

Page 19 of 112 © Train Signal, Inc., 2002-2003
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4. On the Save As screen, open the Save in drop down menu and select the Sales Reports
folder that you created eatlier as the location to save this file. Once you have selected
the folder, enter the filename sales report 03.txt. Then click on the Save button and
close Notepad.

savens 2lx
Savein: |y Sales Reports x| e BctE-

History
[H] Deskiop
2 My Documents
{5 My Computer
=5 3% Flopry 14)
=3 Local Disk [C]

& Compact Disc [ %
My Network Places

File name: (@es 1eport D24t =l Save |
Sawe a5 bype [Tet Documents (-] | Cancel
Encoding [ensi =l

2|

5. Within Windows Explorer, right click on the Sales Reports folder and select Sharing.

Documents  Program Files WIMMT el Open
and Setkings Explore
Search,..

Send To 3

Cuk
Copy

Create Shortcut
Delete
Rename

Properties

6. On the Sharing tab, select Share this folder and click OK to apply your changes.

Sales Reporte Properties llzl

General Sharing I Secunlyl

“f'ou can share this folder among other users an your
network. To enable sharing for this folder, click Share this
folder.

" Do hot share this folder

0% Ghare this folder <:

Share name: ISaIes Reparts j
Comment: I
User limit: & Maimum allowed

= Allow lﬁ_l Users
To set permissions for how users access this
falder over the network, click Permissions MI
To configure settings for Offine access to 8
this shared folder, click Caching. ﬂl
Mew Share |
Cancel | Apply |
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7. Notice that there is now a hand holding the Sales Reports folder, meaning that this
folder is being shared on the network.

@ @ @B/

............................... WINMT

Sales Reports

Installing a VPN Server through the RRAS setup wizard

SRV-1 has one NIC that is directly attached to the Internet that will be configured as Green
Lizard’s VPN Server. This NIC will serve as the public side of the VPN Server and will
allow VPN clients to find SRV-1 across the Internet.

1. Log on to SRV-1. In order for you to install SRV-1 as a VPN server, you will need to
configure and enable the Routing and Remote Access Server (RRAS) first. Notice that
RRAS is installed as part of the Windows 2000 server installation. It is located under
Administrative Tools. On SRV-1, go to Start>Programs—>Administrative Tools and
click on Routing and Remote Access. Right click SRV-1 and then click Configure
and Enable Routing And Remote Access. This will bring up the Routing and
Remote Access Server Setup Wizard, just click Next to continue.

2. Routing and Eemot=iaeg ilglﬂ Routing and Remote Access Server Setup Wizard 5'
Jaon wew || o | B@E|XER 2 b
Tree I SRV-L (local) Welcome to the Routing and Remote
Access Server Setup Wizard
ﬁ_ Routing and Remate Access
%Wﬁrvar ane @ Configure the Routing and Remote Access Server This wizard helps you set up your server so that you can
Configure and Enable Routing and Rem: 55 cunntect Itu UtlhEl networks and allow connections from
Disabie Routing andRemote Aocess tess, on the Action menu, click A DE s
Remote Access. i i
all Tasks » To continue, click Next
View » 13 up a Routing and Remote Access
Delete
Refresh
Properties
Help
< Back. eyt > Cancel
Routing and Remote Access Configuration Wizard K
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On the Common Configurations page, there are 5 common configurations for you to
choose from. Within RRAS, there are many services that you can choose from other
than just a VPN server. You can turn your computer into a NAT server or a Network
router, to name a few. These other services are covered in great detail in both Lab 7 and
Lab 9. For now, select the Virtual private network (VPN) server and click Next to

continue with the installation.

Common Configurations
Y'ou can select from several common configurations.

Routing and Remote Access Server Setup Wizard

x|

" Internet connection server

" Remote access server
Enable remate computers to dial in to this netwark.

I:>(:' Yirtual private network [¥PN] server

" Network router
Enable this network to communicate with other netwarks.

~ Manually configured server
Start the server with default settings.

Enable all of the computers on thiz network. to connect to the Internet.

Enable remate computers to connect to this network through the Internet.

< Back

gt
A

Cancel |

3. This will bring you to the Remote Client Protocols screen. For Green Lizard’s VPN,

TCP/IP is the only protocol that is required for remote access through the VPN setver.
This protocol should be installed by default. Just verify that TCP/IP is listed in the

Protocols list and click Next to continue.

Routing and Remote Access Server Setup Wizard

Remote Client Protocols

The pratocols required for PN access must be available on thiz server.

x|

Pratacals:

Werify that the protocols required on this server for WPMN clients are listed below.

TCRAP

ez, all of the available protocols are on this list

" Mo, | need b add protocals

< Back

Mgt >
X

Cancel |
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The next screen of the wizard will ask you to specify the Internet connection that the
VPN server uses. In most real world cases, you will be connecting your VPN server’s
2™ network card (public network card) to the device supplying you with the Internet
connection (i.e. DSL Router, Cable Modem or T-1 Router).

Under Internet connections, there are 2 network interfaces for you to choose from.
MAKE SURE that you select the interface with the public IP address. In the lab, this
interface should be marked public, with the IP address of 15.15.15.15. Remember, in a
real world scenario, your Internet Service Provider provides this address to you and the
interface would be connected to the public side of your network. Therefore, highlight
Public and click Next.

Routing and Remote Access Server Setup Wizard 5[
Internet Connection .
Remate VPN clients and routers use & single connection to access this server b

through the: Internet.

Specify the [ntemet connection that this server uses,

Internet connections:

Marne | Deszcription ‘ IP &ddress |
<Nuointemet connection:

Private 3Com 3CH18 Integrated ... 192.168.1.201
Public FETIES ] g 151515 15

< Back N) Cancel |

On the next screen, you will be asked to either select to Automatically assign IP
addresses to your remote users or to assign their IP address From a specified range of
addresses. Since you do not have a DHCP server setup on your network that handles
IP address assignment, you will select From a specified range of addresses and click
Next.

Routing and Remote Access Seryer Setup Wizard x|
IP Address Assignment .
‘f'ou can select the method for assigning IP addresses lo remote clients. &.J

How do vou want [P addresses to be assigned to remote clients?

€ Automatically

If you use a DHCP server to assign addresses, confirm that it is configured properlp.
IF you do not use & DHCP server, this server will generate the addiesses.

|:'\>(:' From a specified range of addreszes
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6. This will bring you to the Address Range Assignment screen. Click on New to specify
the address range. For this lab, you will enter 192.168.1.100 as the Start IP address and
192.168.1.101 as the End IP address, click OK and Next to continue. This will give you
a total of 2 IP addresses for your remote access client to lease. These IP addresses will
be returned to this static address pool as soon as your remote access client is done with
its VPN session. On a production VPN server it is very important that you specify
enough addresses to handle all of your remote access clients at once AND that the
addresses you specify are not in use anywhere else on the network.

Routing and Remote Access Server Setup Wizard

Address Range Assignment
“ou can specify the address ranges that this server will use to assion addresses to
temote clignis.

Type a starting IF address and either an ending IF addresz or the number of
addreszes in the range.

Enter the addiess 1anges (static paols] that yau want ta use. This server will assign al of
the addresses in the first range before continuing to the nest

Address ranges:
Fram [ To | Number |

Start IP address: I 132 168 . 1 100

End IP addiess: [192.188. 1 101

N - e Mumber of addresses: I 2

Cancel
< Back I Nest> Cancel

7. On the next screen, you will be asked if you want to use a RADIUS server. For this lab,
just select No, I don’t want to set up this server to use RADIUS now and click
Next.

Routing and Remote Access Seryver Setup Wizard

M ing Multiple R te A Servers i
“r'ou can manage all of your remote access servers centrally. %

A Remote Authentication Dial-ln Uszer Service [RADIUS] server provides a central
authentication databaze for multiple remote access servers and collects accounting
information about remate connections.

[io you want to set up this remaote access server to uze an existing RADIUS server?
' No, | don't want to set up this server to use RADIUS now
7 Wes, | wark to use a RADIUS server

&) Windows provides a BADIUS solution called Intemet Authentication 5 ervice [145)
az an optional compaonent that vou can install through Add/Remove Pragrams.

< Back Mewt > Cancel
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8. On the last screen of the wizard, click Finish and then OK on the DHCP Relay Agent
message. This is just a reminder about setting up a DHCP Relay Agent propetly, if you
have a DHCP server located on a different subnet. You are now finished installing the
VPN server using the wizard.

ot g ol et At vs Serves Selug Wizard I

Cormpliting the Routing and Hemote
Avcess Server Setup Wizard

Yoo baven scemeshully condiuansd 8 VIH serves

T loss s wiamed, ek Frich

< ek, Carcel

Routing and Remote Access 5[

To support the relaying of DHCP messages from remate access clients, you must configure the properties of the
DHCP Relay Agent with the [P address of your DHCP server,

Manually configuring RRAS as a VPN server

The proceeding steps showed you how to setup up a VPN server using the RRAS wizard but
it is important to know how to setup the VPN server manually (without the wizard) as well.
From the previous installation, you have already enabled RRAS. In order to show you the
alternative way, you have to disable RRAS first. Disabling RRAS will result in all of your
current settings being reset.

1. Open RRAS,; right click SRV-1 and click Disable Routing and Remote Access. Also
click Yes to continue disabling the router and removing its configuration.

5 Buulies and Bemote Access =10l
won Yo |4 | Bm XEEHE

Tree l 1 (el

[ ot et Rt Aacess | oime [

tertaen

=
B sorve
« ) I

Routing and Remote Access il

‘You are disabling the rauter and removing its configuration. To re-enable the rauter, you will have ta reconfigure it.
Do you want ko continue?

I
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2. After you see the red down arrow, indicating that RRAS is disabled, right click SRV-1
again and click Configure and Enable Routing And Remote Access.

R
Aton Yew |0 = B@E XS @

Tree | V-1 (ool

{8 Roucng and Remcte Access -

! Qm .\l‘) Configure the Routing s Remote Atcess Server

cess, on the Action menu, click
Remote Access.

g 3 FIOUtng e Remets ACciss

iew 3

Rlouting and Remats Access Configuration wizard

3. This will bring up the Routing and Remote Access Server Setup Wizard, just click Next

to continue.
[romtons ot Remote accews server st weard —————

4. Again, on the Common Configurations page, there are 5 common configurations for you
to choose from. This time, you will select Manually configured server to start the
server with default settings. Just click Next to continue with the installation.

Welcome to the Routing and Remote
Access Server Setup Wizard

This wizard helps you set up your server so that you can
connect to other networks and allow connections from
remate clients.

To continue, click Next

[ [ [ e

Routing and Remote Access Server Setup Wizard x|
Common Configurations .-
You an select fram several commen configurations &

" Internet connection server
Enable all of the computers on this network to connect to the Intemet

" Remote access server

Enable remaote computers ta dial in to this network.
" Virtual private network [VPN) server

Enable remate computers to connect ta this network through the Intemet.
" Metwork router

Enable this netwnrk fn communicate with other netwarks.

= Manually configured server
Start the server with default settings.

< Back I Nexl)E I Cancel
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5. Click Finish and you will complete the installation. Also, click Yes to start the RRAS
service. You have now enabled the Routing and Remote Access service, but you still
need to configure the properties of the VPN.

Routing and Remote Access Server Setup Wizard x|

< Back Firsh Cancel

Routing and Remote Access 5[

Completing the Routing and Remote
Access Server Setup Wizard

“windows has configured this server as a remate access
server and router with default settings. Use the Routing and
Fiemaote Access administrative tool to change these settings.

To close this wizard, click Finish

& The Routing and Remote Access service has now been installed. Da vou wank ta start the service?

Yﬁ I Mo |

Configuring the VPN properties

There are many different configurable properties for the VPN Server. To configure the
VPN server, you will first have to open the Routing and Remote Access properties.

1. To do this just right click on SRV-1 and select Properties.

BEE]
| action  view |j<:-»||><. B2 |
Tree I SRY-1 {local)

E Fouting and Remoate Access _N:me
Server Status E_Rnutmg Interfaces

=

"8 Routine Canfigure and Enable Routing and Remote Aocess
E Ports Disable Routing and Remote Access

2 Remobl ) Tasks
B IPRou
EF remot Miew 4
] Remab

Delete
Refresh
Export List...

Help |

Opens property sheet for the current selection,
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This will bring up the SRV-1 Properties dialog box, where you configure Routing and
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Remote Access. There are 5 tabs for you to select from (General, Security, IP, PPP and
Event Logging) and many options to configure. The General tab allows you to enable
the RRAS role that this computer will take on. In order for SRV-1 to act as a remote
access server, you will have to make sure that the Remote access server option is
checked. For now, leave the Router option checked and LAN and demand-dial
routing selected as they are default settings. We will cover these options later in the lab.

3. The next tab is the Security tab.

SR¥Y-1 {local) Properties
General | Sacurityl IP I FFP I Ewent Loggingl

=) o
T

Fouting and Remate Access

21|

Enable this camputer a5 &

¥ Router

" Local area netwark [LAM] routing only

& L&N and demand-dial routing
¥ Remote access sarver <:|

ok I Cancel |

Apply |

It allows you to choose different Authentication

methods for the VPN Server, which we will cover in greater detail later in this lab. This
tab also allows you to select an Accounting provider, which specifies where to save log

files.

Page 28 of 112

SRY-1 (local) Properties

General  Security I\p I EFP I Event Loggingl

and demand-dial routers

Authentication provider:

IW’indows Authentication

Authentication Methads. .

The accounting provider maintains a log of connection requests and
SEESI0NS.

Accounting provider:

The authentication provider validates credentials for remate access clients

j Configure... |

gl 5|

‘windows Accounting j Corfigure... |
ok Cancel Apply
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4. 'The third tab is the IP tab. This is where you can configure how IP address assighments

for your clients are handled. You can either choose to automatically assign IP addresses
create your own address pool. Since there is no DHCP server
setup on your network, you will select Static address pool and click Add to add to your
address range. In this lab you will enter 192.168.1.100 as the Start IP address and

using DHCP or you can

192.168.1.101 as the End

¥ Enable IP routing

[V Allow |P-based remote access and de

SRY-1 (local) Properties el B

Genera\l Secuity P |PPP | Event Logg\ngl

IP address and click OK.

mand-dial connections

i~ IP address assignment
This server can assign |P addresses by

Lalls! Configuration Protocol [DHCF)
% Static addiess pool

using

Fom | To [Mumber | IPaddr | Mask | New Address Range 2=

addresses in the range.

Start IP address: 182 168, 1 100
-A E- Edit... Remnoye
— e | End IP address: 12168 1 10
Use the following adapter to obtain DHCP, DNS, and 'WINS addresses for
dial-up clients. Mumber of addresses: I 2
Adapter [Alow RAS to select adapter =l

oK

| concel | apay |

Type a statting IP address and either an ending IF address ar the number of

m Cancel |

5. The fourth tab is the PPP, or Point-to-Point Protocol, tab. The PPP settings are enabled
by default and can be left alone. They are not necessary for a VPN connection using a
dedicated connection to the Internet (i.e. DSL, T1, etc.). So, for Green Lizard, leave

these settings as they are.

SRY-1 (local) Properties 2xl
Genelall Seculityl P FRF IEvaml Loggimgl

This server can use the fallowing Point-to-Paint Protacol [PPP] aptions.
Remate sccess policies detemine which settings are used for an individual
conhection

Iv Mulilink connections
¥ Dynamic bandwidth control using BAP or BACP
¥ Link control protocol [LCP) extensions

V¥ Software comprassion

Ok I Cancel Apply

Page 29 of 112

© Train Signal, Inc., 2002-2003



0.

alr

The last tab is the Event Logging tab. This tab allows you to choose different logging
options. All events are logged in the system log of the event viewer. The default is set
on Log errors and warnings.

i
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SRY-1 {local) Properties

2l

Generall Secuntyl IP I PPP  EwentLogging I

Event lngging:

" Log emors only

1+ Log emors and warnings

1~ Log the maximum amount of information

" Disable evert logging

™ Enable Point-to-Point Protocol (PPF) logging

o]

Cancel | Apply

7. When you install the VPN server through the Routing and Remote Access Setup wizard

128 PPTP and 128 L2TP ports are typically created. However, when you install the
VPN Server using the manual setup just 5 PPTP and 5 L2TP ports are typically created.
Regardless of the number of ports created initially, you have complete control over the
number of ports that are available to your remote access users. Keep in mind that each
port represents one “opening” through your VPN server - so each connected user will
use one port. You should set the number of ports to a number that is great enough to
support all of your remote access users at any one given time while not opening up
excess ports, creating a security issue. To configure the number of ports, right click
Ports and select Properties.

Tree I Ports
E Routing and Remote Access Mame % | Device | Comment Status
Server Skakls @WF\N Miniport (PPTF) (YPMN3-4) WPN Inactive
E% SRY-1 (local) @WF\N Miniport (PPTP) (WPM3-3) VPN Inactive
E IP Routing @WF\N Miniport (PPTP) (VPM3-2)  WPN Inactive
E-{] Remote Access Logging 22w Minipart (PPTP) (VPN3-1) PN Inactive
B Routing Interfaces 22 W Minipart (PPTP) (VPN3-0) VPN Inactive
Vi @WF\N Miniport (L2TP) (VPRZ2-4) WP Inactive
i -5 Reme @wnm Miniport (L2TP) (YPMZ-3) WPN Inactive
E-EF Rem  poprecy TP WaN Minipart (L2TP) (YPH2-2)  YPN Inactive
Export List. .. @WF\N Miniport (L2TP) (YPMZ-1)  WPN Inactive
@WF\N Miniport (L2TP) (¥PR2-0) WP Inactive
@Direct Parallel (LPTL) PARALLEL Inactive
Help
4| |
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8. This will bring up the Ports Properties dialog box. There are 2 types of VPN ports,

WAN Miniport (PPTP) and WAN Miniport (L2TP). Select WAN Miniport (PPTP)
and click Configure.

Ports Properties A |
Devices |
Routing and Remote Access [RRAS) uzes the devices listed below.
vice
[ Ainiport [FETF] r uting 5
Wik Minipart [L2TP) R&S /Routing L2TP 5
Direct Parallel Fauting Parallel 1
Configure...

ak I Cancel | Spply |

9. This will open the Configure Device — WAN Miniport (PPTP) dialog box. From here,
you can specify the function of the PPTP ports and the number of virtual ports to
create. Enter 10 as the maximum number of PPTP ports and verify that the Remote
access (inbound) is selected for inbound connections. This will enable remote access

through PPTP ports. Since this is not a modem port, just leave the phone number field
blank and click OK.

Configure Device - WAN Miniport (PPTE) 2l

*Y'ou can wze this device for remote access requests or demand-dial
connections.

¥ Remote access connections (inbound only)

[ Demand-dial routing connections (inbound and outhound)

Phone nurmber for this device: I

Y'ou can get a magimumn pork limit for a device that supports multiple ports.

M awimunm parts:

Ok ‘E | Cancel
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10. Select WAN Miniport (L2TP) in the Ports Properties dialog box and click Configure.
This time you will disable all of the L2TP ports. Uncheck Remote access connections
(inbound only) and uncheck the Demand-dial routing connections (inbound and
outbound). Click OK and then click OK on the Ports Properties dialog box to
complete the configuration.

Configure Device - WAN Minipork (LZTP)

aquests or demand-dial

2

[~ Remote access connections (inbound only)

" Demand-dial routing connections [inbound and outhound)

mber for this device:
You can get a maximum port limit for a device that supports multiple ports.

b aximum ports; 5 =

Dé I Cancel |

11. As you can see from the right pane of the RRAS console, you now have 10 PPTP ports
and no L2TP ports available for your VPN clients.

é Routing and Remote Access ;Iglll
J&ction Yigw |J¢'-D|||@ |
Tree I Ports
E Routing and Remate Access MName | Device | Comment | Status |
Server Status @WAN Miniport (PPTP) (WPMN3-4)  WPM Inactive
EI% SRY-1 (local) @WAN Miniport (PPTPY (YPH3-3)  WPM Inactive
& EL 1P Routing 2 waN Miniport (PPTPY (YPN3-2) WP Inactive
{10 Remote Access Logging 2 waN Miniport (PPTPY (YPH3-1) YR Inactive
2 Routing Inkerfaces 22w AN Miniport (PPTP) (YPN3-0) PN Inactive
g @Direct Parallel (LPT1} PARALLEL Inactive
B Remake Access Clisnts (0 2 wan Miniport (PPTP) (YPNZ-S) VPN Inactive
-5 Remote Access Policies 22 wan Miniport (PPTP) (VPNZ-6) VPN Inactive
I%WMN Miniport (PPTP) (YPMN3-7)  WPN Inactive
@WAN Miniport (PPTP) (WPMN3-8)  WPM Inactive
%WAN Miniport (PPTP) (WPM3-9)  WPM Inactive
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Setting up a VPN client on Client-1

To setup a VPN client on Client-1, you will have to create a user account within your
domain. You will create a user account named John Stacey for your remote access user
account.

1. Log on to SRV-11 and open the Active Directory Users and Computers console by
going to Start>Programs->Administrative Tools>Active Directory Users and
Computers. In the left pane of the console, open the container named Users.

Tree I Users 19 objects

[ Type  a|

@ fictive Directary Users and Camputers [Srv-11,greenlizardbooks,com] | |H2me

E@ greenlizardbooks ., com ﬁiDomain Compukers Securiby
123 Builkin ﬁDomain Controllers Security
I:l Compukers ﬂiDamain Guests Security
~{€3] Domain Cantrollers €7 Domain Users Security

[Z ForeignSecuricyPrincipals ﬁEnterprise Admins

Security
= -
> emiam Palimo Tem s ke Cunmees S wika
A ] _>I_I

2. To create a user account, right click on the Users container in the left pane and select
New->User.

&% Active Directory Users and Computers 10l x|
J Console  Window  Help | _|= Lll
|Jﬁction Wiew |J¢=#||X|@J;E@h?@b |
Tree I Users 19 ohjects
@ Active Directary Users and Computers [Srv-11.greenlizardbooks, cc | M3Me Type il
E@ greenlizardbooks, com !ﬁCert Publishers Security ¢
(- [ Buikin €T 0nstdmins Security ¢
D Computers @DnsUpdateProxy Security ¢
(&3] Domain Controllers @Domaln Admins Security
(0 ForeignSecurityPrincipals €TI00main Computers Security ¢
- Delegate Contral. .. ﬁzDUmain Controllers Security ¢
Find. .. ﬁzDUmain Guests Security
!ﬁDomain Users Security
Computer !ﬁEntarprise Adrins Security ¢
All Tasks b Conback €7 Group Policy Creator Cwners Security ¢
View » E"_Ot'p Guest User
tinter
Mews Wiindow from Here %krbtgt —
M ﬁERAS and TS Servers Security ¢
Refresh Shared Folder €7 5chema Admins Security G—
Exzpart List, . g Sry-1 User
Properties !3 TsInternetser User =
| | < »
- Help
Create a new objeerm——e—— |
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This will bring up a wizard for creating a new user. On the first screen, type in the first
and last name for the user (John Stacey) and, for the logon name, type in the first initial
of the first name and the full last name (jstacey) and click Next. On the next screen
you must enter a password for this new user account. Type in mega as the password

and click Next.

New Dbject - User

@ Create in:  greenlizardbooks. com/Users

) [ Object - User

g Create i mieenlizadbacks com/Isers

User logon name

First name: |J ohn Initals
Last name: IStacey
Full name: |J ohn Stacey

||slace)l

User logon niame (preindows 2000)

|@areeniizardbocks.com

Il

GREENLIZARDEOOK!,

Iislacey

Password:

I™ User must change password at next logon

Confim password

I User cannat change passward
I Passward never epires

™ Accountis disabled

< Back

Nt >
X

Cancel

< Back I Next>FI

Canicel

The final screen is just a summary of all the information that you entered in the wizard.
Confirm that the information is correct and click Finish. Now, within the Active
Directory Users and Computers console, you should see a user account named Jobn
Stacey located in the Users container.

) e e
@ ictive Directory Users and Compute | Mame 7 Type =+
= @ greenlizardbooks, com €7 Administrator User
g Createin:  greenlizardbooks. com/Users B Builin €5 Cort Publishers —
- (2] Computers €5 Dnsadmins Security
‘wfhen you click Finish, the following abiject wil be created: {8 Domain Contrallers € CnsUpdateprosy Securit
[ ForeignsecurityPrindipals | € Damain Admins Securit
Fullname: John Stacey Users €7 Domain Computers Securit:
User logon name: jstacey@greeniizardbooks. com @Domain Controllers Securit
ﬂEDomaln Guests Securit
@Domain Users Securit
ﬂEEntamnse Admins Securit:
ﬂEGrnup Palicy Creator Owners Securit
%Guest User
en
%krbtg User
ﬂERAS and TAS Servers Securit
<Back Cancel | ﬂ}s:hema Adriins SECUrt o
J | Ol | ;

5. In order for John Stacey to gain remote access to the network, he must be given remote
access permissions. To accomplish this right click on Jobn Stacey and select Properties.

Copy..
Add members to a graup. .

Disable Account
Reset Password, ..
Move...

Open home page
Send mai

&l Tasks r

Delete
Rename
Refresh

Properties R

Help
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6. This will bring you to the John Stacey Properties dialog box. There are 3 different
options you can set for Remote Access Permission: Allow access, Deny access, and
Control access through Remote Access Policy. Notice that the last option is grayed out
at the moment. This is because your domain is currently in mixed mode, which we will
cover later in the next lab. For now, select the Dial-in tab and select Allow access
under Remote Access Permission (Dial-in or VPN). This will give John the remote
access permission necessary for either a dial-up or VPN connection. Click OK when
you are done with this configuration.

John Stacey Properties 2lx
Remote control | Terminal Services Profile

General | Addiess | Account | Profie | Telephones | Organization
Member Of Disn | Envienment | Sessions

i~ Remate Access Permission [Dialin or WPN)
% Allow acosss
" Deny access

1 Contol access trough Remate Access Policy
I | Wity CallerAD:

- Callback Option;
' No Callback

" Set by Caller (Routing and Remate Access Service only)

" Always Callback to
I | &ssign & Static P Address ) ) )

| Apply Static Routes

Diefine rovtes to enable for this Diskin Siatie Falies
connection. =

Cancel Apply

7. Next, to setup a VPN client, log on to Client-1 and go to Start=>Settings=>Network
and Dial-up Connections and click on Make New Connection. This will bring up
the Network Connection Wizard. Click Next to continue.

Network Connection Wizard

Welcome to the Network
Connection Wizard

Using this wizard you can create a connection to other
computers and networks, enabling applications such as
e-mail, Web browsing. file sharing, and printing.

To continue, click Next

< Back I Next > ; I Cancel

3
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8. On the Network Connection Type page, there are 5 network connection types for you to
choose from, including setting up your computer as a VPN client. You can set up your
computer to dial-up to a LAN, to the Internet, to accept incoming connections, or to
connect directly to another computer. For now, select Connect to a private network
through the Internet and click Next to continue.

Network Connection Wizard

Metwork Connection Type
“Vou can choose the type of network connection you want to create, based on
your network, configuration and pour networking needs,

" Dial-up to private network
Connect using my phone line (madem or [SDN).

" Dial-up to the Internet
Connect ta the [nternet using my phone line [modem or ISDM]

|:> (¥ Connect to a private network through the Internet
Create a Virtual Private Metwork [VPMN] connection or tunnel' through the Intemnet.

" Accept incoming connections
Let other computers connect to mine by phone line, the Intemnet, or direct cable

" Connect dirtectly to another computer
Connect using my serial, parallel. or infrared port.

< Back I Next)i I Cancel

9. The next screen of the wizard will ask you to enter the Destination Address. This is the
public IP address of your VPN server. For this lab, the destination IP address will be
15.15.15.15. Click Next to continue.
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Network Connection Wizard

Destination Address
“wihat iz the name o address of the destination?

Type the host name or P address of the computer or network. to which you are
connecting.

0zt name or dress [zuch as microsoft.com or 123.45.6.78]:
|15 15.15.15

< Back I Mest > & I Cancel
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10. This will bring you to the Connection Availability screen. On this screen, you have the
choice to setup this new connection so that it is available to all users of Client-1 or just
yourself. In this lab, you will set it up for all users of Client-1. Select For all users and

click Next to continue.

Metwork Connection Wizard

Counnection Ay adallity
"o gy make e rew correchion avalable Lo ol uses. o gt yoursel.

“Yiows mayy miskes this correction awvadabi 1o ol usess, o koo it ol o your owm use. &
Gonnacson ttoted i jur rofle vl nol ba &valsbls Lrksss you aie kgged on.
Caeate thix connnction

% Foe oll e

" Dinky for myank

< Back N 3 Canenl |

11. On the last screen of the wizard, you can give your VPN connection any name that you
like. The default name is Virtual Private Connection. Click Finish and your VPN client

setup is complete.

Completing the Metwork
Connection Wizard

Ty ther rm g v by e B compmction

To craste it conneckon and tave £ inha
Hetwod ard Dighup Connections folda. chel.

To edi it connecton in the Network and Dishp
Conrsctions fokder, sebect i, chek File. and then cick
[ —

I A shutcis o vy skl

cisck [ Feshy ] cacd

12. Once you are done setting up your VPN client, you will immediately get the Connect

Virtual Private Connection dialog box.

This is where you will initiate your VPN

connection. Before you connect to your LAN, click on the Properties button to see

what settings are configurable for the VPN client.

i

Connect ¥irtual Private Connection

User name: I

Password: I

" Save Password

Cancel Plopities | Help |

Page 37 of 112

© Train Signal, Inc., 2002-2003



i
alrainSIGNAL. ..

Configuring the VPN client properties

1. Clicking the Properties button brings up the Virtual Private Connection dialog box.
There are 5 tabs (General, Options, Security, Networking and Sharing) for you to select
and many options to configure. The General tab is where you specify the public IP
address of the remote VPN server that you want to connect to. The First connect
option allows you to specify a dial-up connection to automatically connect to before you
attempt to access the VPN Server. This would be your normal connection to the
Internet, typically a dial-up connection.

irtual Private Connection 2x|

General IUDt\unsl Secunlpl Nelwulklngl Sharlngl

Host name or IP address of destination [such as microsoft.com or
123.45.6.78)

First connect

‘Windows can first connect the public networl:, such as the
|ntermet, before tiving to establish this vitual connection.

I Dil anather connection first:

I =
[V Show icon in taskbar when connected

2. The next tab is the Options tab. Most of these settings are self-explanatory and, by
default, none of these settings have to be changed in order to connect to the VPN Server

Virtual Private Connection d |

General Options I Se:ulilyl Nelwurkingl Sharingl

r— Dialing option:
[V Displap progress while connecting
¥ Prompt for name and passwaord, certificate, etc.

[ Includs Windows logon domain

r~ Fiedialing option:

Redial attempts: |3 _I:
Tirme between redial attempts: I‘\ minute vI
Idle time before hanging up: I"EVEf 'I

[~ Redial if ling is dropped

Cancel |

Page 38 of 112 © Train Signal, Inc., 2002-2003



i
alrainSIGNAL. ..

3. 'The third tab is the Security tab, which allows you to fine tune the security for your VPN
connection. You can choose ecither Typical or Advanced. Typical, the default, only
allows you to control basic options. In this case you have the ability to disable
encryption over the VPN connection and choose whether or not to automatically log
you in to the VPN Server. The Advanced option allows you to choose exactly which
remote authentication protocols you want to allow, including the use of smart cards. We
will take a closer look at remote authentication protocols later in this lab.

¥irtual Private Connection 8 21xl
General | Options  Secunty | Metworking | Sharing |
—Security option:

% Typical [recommended settings)
Walidate my identity as follows:
| Reuire secured password =l
™ Automaticaly use my Windows logon name and

password (and domain if any]

[V Require data encryption [disconnect if none]

" Advanced [custom settings)
Using these settings requires & knowledae s
of security pratocals. 9

4. 'The forth tab is the Networking tab. It allows you to select which VPN protocol (L2TP
or PPTP) you want to use for the connection. The default setting is set to Automatic.
The automatic setting will have your computer attempt to use L2TP first and then use
PPTP if L2TP is not available on the VPN Server. You can also install or uninstall any
network components that you want to use for this connection. The default components
are typically left in place, as they allow for “normal” usage of the Windows 2000 network
that the VPN client is connected to. You can configure these components individually
by highlighting them and clicking on Properties.

virtual Private Connection x|

General | Options | Secuiy Metwarking | Sharing |

Typs of YPH server | am caling

Settings

Companents checked are uzed by this connection:

Cliert for Microsoft Networks

Install.. Uninstall Properties

Desciption

Tranzmission Control Protocol/internet Protocal. The default
wide area network protocal that provides communication
acioss diverse interconnected netwarks.

Cancel
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5. The last tab is the Sharing tab. It allows you to enable Internet Connection Sharing (ICS)
for the VPN connection. If, for example, you have other computers on Client-1’s LAN,
enabling ICS will allow these computers to access external resources through the VPN
connection as well. For security reasons, enabling this setting on a VPN client that

connects to a corporate network is not a good idea. Leave ICS disabled (unchecked)
and click OK to close the Virtual Private Connection dialog box.

Virtual Private Connection 2%

General | Options | Secury | Networking Shaing |

Intermet Connection Sharing allows other computers on your
L.

1 local network to access external resources thiough this
conhection.

i~ Shared acc

Local netwaork operation may be momentarily disrupted

™ Enablz Intemnet Connection Sharing far this connection

- On:demand dizling

With on-demand dialing, when another somputer on your local
network attempts to access extemal resources, this connection
willbe dialed Butomatically.

[¥ | Enablz on-demand digling

Settings...
Cancel

6. Alright, now let’s attempt to access the VPN server. Type in jstacey as the user name
and mega as the password. Remember, this is the new user you added to the Users

container in Active Directory Users and Computers in SRV-11 earlier. Click Connect to
establish the VPN connection.

Connect Yirtual Private Connection

U ser name: IiStaCE_'r'

=1
Password: I"’“‘" Your passward is mega

[ Save Password

Connect |: I Cancel | Properties | Help |
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The first time you establish a Virtual Private Connection, you will get this Connection
Complete dialog box. You can either check or uncheck the Do not display this
message again box. Just click OK to close the dialog box.

Connection Complete x|

1 irtual Private Connection’ is now connected.
L
To check the status of thiz connection or digconnect, right-click

its icon in the Network Connections folder, or click itz icon on the
tazkbar [if present)

™ Do ot display this message again

In order to test access to your internal network, you can use the ping utility to ping SRV-
11. Go to Start>Run, type in emd and click OK to open the command prompt.
Within the command prompt, type in ping 192.168.1.1, which is the domain controller
on your network, and press Enter. If you receive four replies from 192.168.1.1, then
you are able to communicate with SRV-11 through your VPN server.

£t Windd 2008 [U
Ran 21| |
. IC:~\>ping 192.168.1.1
Type the name of a program, Folder, docurnent, or Pinging 192.168.1.1 with 32 bytes of data:
Internet resource, and Windows will open it For you. Reply from 192 .168.1 yte_‘—:iz time<{1@ns
2 time<1Bms

2 time<iBns
open: | emd| = 2 N % tinecion Lot

OK& | Cancel | Browse, ., |

To check Client-1’s virtual address information, type in ipconfig and press Enter at the
command prompt. The IPCONFIG utility gives you some basic output about the IP
configuration of the network interface on Client-1. Client-1’s virtual address should be
an IP address from the range of 192.168.1.100 to 192.168.1.101. This IP address is
randomly selected from the IP address range that you setup eatrlier in the static address
pool on your VPN server. Therefore, you should have either 192.168.1.100 or
192.168.1.101 as your virtual IP address. After verifying this configuration, type in exit
and press Enter to close the command prompt.

Lost = B <Bz loss).

Mic ndi 088 [Uersion 5.00.21951
<C> Copyright 1985-1999 M oft Corp-

C: >ipconfig
Windows 2008 IP Configuration
Ethernet adapter Local Area Connections:

Connection—specific DNS Suffix . :
: 15.15.15.28

: 255.8.8.8

: 192.168.1.1061
= 255.255.255.255
: 192.168.1.161
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10. Also, click on the 2 computers icon in the lower right corner of your taskbar that
indicates that your Virtual Private Connection is active.

Virkual Private Conneckion
Sent: 566,743 bytes
Received: 129,149 bytes

G 343PM ‘

11. Double clicking this icon will bring up the Virtual Private Connection Status dialog box.
There are 2 tabs (General and Details) for you to select. The General tab provides you
with connection status and activity information. You can also click on the disconnect
button to disconnect the VPN session or on the Properties button to configure your

VPN client, which is the Virtual Private Connection dialog box that you were in earlier.
20

General |Details|

i~ Connection

Status: Connected
Duration: 00:06:13

i~ Activi

i
Sent — S5 —  Received
L&

Bytes 43293 0212
Compression: 4% 12%
Enrors: i i

Propetties |  Disconnect

Close

12. The Details tab provides information on how you have connected your VPN session,
including which authentication and encryption methods the VPN connection is using.
As you see, PPP is the remote access protocol being used to establish this connection.
The LAN protocol is TCP/IP and MS-CHAP V2 was used to authenticate the remote
access client. Further down, you should also see that 56-bit Microsoft Point-to-Point
Encryption (MPPE) is being used for data encryption and that Microsoft Point-to-Point
Compression (MPPC) is the compression method. If you scroll down further, you will
see the server and client IP addresses that are used during this VPN session. Click on
the Close button after you have verified this information.

virtual Private Connection Status

General Details

Fioperty [ value -
Server lype PPP

Tranzports TCRAR

Authentication M5 CHAP W2

Encryption MPPE G& -
Campression MPPC

PPP multilink, framing On -
| | »

Close
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Join Client-1 to the Greenlizard.com Domain

Joining Client-1 to the domain is not a technical requirement of setting up a VPN, but it
better simulates a company environment. Joining a computer to a domain will provide
centralized authentication, policy and security. In a real world situation, your computer (the
user’s computer) most likely would have been joined to the domain when it was first
deployed to the end user and not after the user has taken the computer home and formed a
VPN connection.

1.

To join Client-1 to the domain, simply right click the “My Computer” icon on the
desktop and select Properties. From here, select the Network identification tab,
select Properties, sclect Domain and then type in the domain name of the domain
Client-1 will join. You can use the DNS Host name, greenlizardbooks.com, or the
NetBIOS name, greenlizardbook. Remember, NetBIOS names are a single label (no
periods) and can be up to 15 characters in length. Click OK after entering the domain
name. You will then be asked for a username and password. Use jstacey as the account
name and mega as the password from the greenlizardbooks.com domain. When the
computer account has been successfully joined to the domain, it will “welcome you to
the domain” and you should then restart the computer.

After restarting the computer log back on to Client-1. Next, go to Start = Settings >
Network and Dial-up Connections and double click on the Virtual Private
Connection. Just type in jstacey as the user name, mega as the password and click
Connect to establish the VPN connection again.

Accessing the share through the VPN server

1.

Next, see if you can access the sales report file that you shared on the network from
SRV-11 earlier. Browse the network for this resource by double clicking on My
Network Places, clicking on Entire Network, clicking on entire contents and then on
Microsoft Windows Network. From here, double click on the Greenlizardbooks
domain, double click SRV-11 and double click the Sales Reports folder. This final
double click should reveal the sales report 03 file that you created earlier. You can also
access this shared folder by going to Start>Run and then entering the Universal
Naming Convention (UNC): \\SRV-11\Sales Reports

pata e Y =g 3 2
Microsoft Windows | Srv-11

Network :
— 44Sry-1115ales Reports @ EI

Select an ikem to view its SYSVOL Printers Scheduled
description, Tasks
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Troubleshooting tunneling protocols between SRV-1 and Client-1

In this section you will examine the interaction between a L2TP client session and your

current VPN server, which is setup to serve PPTP VPN clients.

1. First, to form a L2TP session, you will have to disconnect your current VPN session and
configure your VPN client properties. To do this click on the Disconnect button in the
General tab. Next, go to Start=>Settings=> Network and Dial-up Connections, click
on Virtual Private Connection. This will bring you to the Connect Virtual Private
Connection dialog box again, click on the Properties button and select the Networking
tab. Click on the down arrow and select Layer 2 Tunneling Protocol (L2TP) as the
type of VPN server you are connecting to. Click OK to complete this configuration.

virtual Private Connection 20x|

Gieneral | Options | Secuiy  Networking | sharing |

GFWPN server | am caling:

(=] Q Clignt for Microsaft Metwarks

Install Uninstall Properties

Descip

Transmissian Caniral Protacal/Intemet Protacal, The defaul
wide area network protocal that provides communication
across diverse interconnected networks

0K Cancel
g

2. Next, in order to support L2TP on the VPN Server, you will have to increase the
number of available L2TP ports (they are currently disabled) on SRV-1. Log on to SRV-
1, go to Start>Programs—>Administrative Tools and click on Routing and Remote
Access. Right click Ports and select Properties.
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E Routing and Remote Access

Jﬂctlon View H@-’lll@

=0l x|

Tree I

Ports

| B Routing and Remote Access
Server Status
=] % SRY-1 (local)
E Routing Inkerfaces
E Remate Access Clients (03
g Wit »
=& IIFR
¥ Remwr Refresh
@ Rem Export List..,

Help

MName T

| Device

Status |

B2 ywaH Hiniport (PPTP
B2 ywaH Hiniport (PPTP
B2 waH Hiniport (PPTP,
B2 waH Hiniport (PPTP,
B2 waH Hiniport (PPTP,
B2 waH Hiniport (PPTP,
B2 waH Hiniport (PPTP,
B2 waH Hiniport (PPTP,

B2 pirect Parallel (LPT1)

PARALLEL

Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive

Opens property sheet for the current selection.
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3. This will bring up the Ports Properties dialog box. Again, there are 2 types of VPN

ports, WAN Miniport (PPTP) and WAN Miniport (L2TP).

(L2TP) and click Configure.

Ports Properties

Devices |

Flauting and Fremete Access (ARG uses the devices listed below.

| Device [ Used By [Tope [ Mumb..

2l

RiS/Routing  PETP 10
Hone L2TP &
Routing Paralel 1

Configure. .. I

Select WAN Miniport

0k | Cancel |

4. Within the Configure Device — WAN Miniport (L2TP) dialog box, you can specify the

function of the L2TP ports and the number of virtual ports available.

Leave the

maximum L2TP ports as is and check the Remote access connections (inbound
only). This will enable remote access through the L2TP ports. Leave the Demand dial-
routing connections (inbound and outbound) unchecked and the phone number field
blank. Click OK.

Configure Device - WAN Miniport (L2TP}

*f'ou can use this device for remate access requests or demand-dial
connections.

Phone number for this device:

Masirnum pots

[¥ Remote acosss connections (inbound only)
I~ Demand-dial oating co

ections [nbound and outhound]

——

*f'ou can set a maximum poit limit for a device that supports multiple ports

21x

5. After you click OK you should see that, along with the 10 available PPTP ports, you also
have 5 L2TP ports currently available for your VPN clients.
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Tres I

| ®1 Routing and Remote Access
Server Status
B SRY-1 (local)
E Routing Interfaces
B Remote Access Clients ()
2
[+ E} 1P Routing
5F Remate Access Policies
[#-[_] Remoke Access Logging

5 available L2TP ports

[ Ports

Name  © [ Device Comment Status
%WANM\nlport(FPTP)(VPNS-Q) YPM Inactive

2 an Miniport (PPTF (YPN3-B)  WPH
B2 yeaH Hiniport (PPTFY (YPNZ-7) WPH
T wran Minipart (PRTPY (YPNG-E) VP
T wan Minipart (PPTPY (YPNG-5) VP
2 wean Finiport (PPTEY (YEN3-4)  WPH
B2 ywaH Hiniport (PPTFY (YPNZ-3) YPH
T wran Minipart (PRTPY (YPNG-Z) VP
T wan Minipart (PPTPY (VPNG-1) VP
22 wean Finiport (PP (YEN3-0)  WPH
%Diract Parallel (LPTL) PARALLEL

Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive

WA Miniport (L2TP) (WPHZ-4)  WPH
WA Miniport (L2TR) (WPHZ-3)  WPN
WAl Miniport (LZTR) (WPHZ-2) PN
WA Miniport (LZTP) (WPHZ-1]  WPM
WiAM Miniport (LETR) (WPHZ-0)  WPM

cEehekekek

Inactive
Inactive
Inactive
Inactive

Inactive
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6. You are now ready to attempt to establish your VPN session using L2TP on Client-1.
Type in jstacey as the user name and mega as the password in the Connect Virtual
Private Connection dialog box. Click Connect to establish the VPN connection.
Almost immediately, you should get an error message. This error message indicates that
there is no valid machine certificate found on Client-1. Your VPN client will not be able
to connect to the VPN server using L2TP until a machine certificate is installed.
Certificate services and L2TP connections will be explored in more depth in the next lab.
For now, your VPN clients will only be able to use PPTP to establish VPN sessions.
Click Cancel on the error message and go back to the Networking tab in the Virtual
Private Connection dialog box. Change the type of VPN server that you are calling back
to Automatic. This setting allows your VPN client to negotiate the most secure
protocol, L2TP, first. Since the VPN server currently doesn’t support L2TP, it will use
PPTP instead.

ot o — T
Error Connecting to ¥irtual Private Eonnec 2=l
& Connecting to 15.15.15.15...
T e Emor 781: The encryption attempt failed becauze no valid certificate
-’1—|— wag found.
— "»,._fj' neTword B e
™ Sowm Pazsawad
| Hedial = 46 | Cancel Hore Info
Correct e i L | =

Remote Authentication Protocols

Remote access servers use authentication to identify a user who wants to remotely access the
LAN. Routing and Remote Access offers many standard authentication protocols to
perform this authentication. These include Password Authentication Protocol (PAP), Shiva
Password Authentication Protocol (SPAP), Challenge Handshake Authentication Protocol
(CHAP), Microsoft CHAP (MS-CHAP), and MS-CHAP v2. MS-CHAP and MS-CHAP v2
are the default authentication protocols enabled within Windows 2000. RRAS also allows
the use of Extensible Authentication Protocols (EAP), which are used with smart cards and
to allow you to load additional third-party protocols. A closer look at each of these Remote
Authentication Protocols follows:

Password Authentication Protocol (PAP) - This is the least secure authentication
protocol of all. It sends clear-text passwords and provides very little protection against
unauthorized access.

Shiva Password Authentication Protocol (SPAP) - This protocol is a 2-way reversible

encryption authentication protocol. It encrypts password data sent between the remote client
and the server. Regardless of this encryption, this protocol is still not a secure protocol.
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Challenge Handshake Authentication Protocol (CHAP) - This protocol allows clients
running non-Microsoft operating systems to communicate with a Windows 2000 server
using encryption. It uses the Message Digest 5 (MD5) one-way encryption scheme to
encrypt the response. It provides a medium level of protection against unauthorized access.

Microsoft CHAP (MS-CHAP) - This protocol is enabled by default on RRAS Servers and
Window 2000 remote access clients. It allows clients running NT version 4.0 and later, or
Windows 95 and later, to communicate with a Windows 2000 server using Microsoft Point-
to-Point Encryption (MPPE). It is also only offers one-way authentication.

MS-CHAP v2 — This protocol is the most secure of all the standard protocols. It is enabled
by default on RRAS servers and Windows 2000 remote access clients. It provides mutual
authentication, stronger data encryption keys, and uses different encryption keys for sending
and receiving. It can be configured on dial-up clients running Windows 2000. It can also be
configured on VPN clients running Windows 2000, Windows NT 4.0 or Windows 98.

Troubleshooting Remote Authentication Protocol settings on SRV-1 and
Client-1

In this section you will examine the interaction between a VPN server and Client-1 when
using different Remote Authentication Protocols on each of them.

1. To demonstrate these settings, you have to first log on to SRV-1. From there, go to
Start = Programs = Administrative Tools = Routing and Remote Access and
open SRV-1 Properties. Right click on SRV-1 and click on Properties. Select the
Security tab and click on the Authentication Methods button.

SRY-1 (local) Properties 21x|
General Seculy [IP | PPP | EventLogaing |

The authentication provider validates credentials for remote access cients
and demand-dial routers.

0k I Cancel Apply
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2. Clicking on the Authentication Methods button will bring up the Authentication
Methods dialog box. From here, you can enable and disable the standard authentication
protocols used on your VPN server. Only those protocols that are checked will be
allowed for client authentication. Microsoft encrypted authentication version 2 (MS-
CHAP v2) and Microsoft encrypted authentication (MS-CHAP) are enabled by default.
In order to test these settings, un-check MS-CHAP and leave MS-CHAP v2 checked, as
the only authentication protocol your VPN server will accept. Click OK and OK again
on the Security tab to complete the configuration.

T

The térver suthentcates iemole syitems by wting the telected method: in
the ceder shown bedow

I Shivia Passwword Autherticontion Proincal [SPAF)
I Unencospted o sword IPAF]
Unautheticansd sccass

(' without

TN

3. Next, log on to Client-1, go to Start>Settings—>Network and Dial-up Connections,
and click on the Virtual Private Connection. This will bring you to the Connect
Virtual Private Connection dialog box, click on the Properties button and select the
Security tab. Select Advanced (custom settings) and click on the Settings button.

Gieneral | Options  Securly | Networking | Sharing |

- Secuity opti
' Typical [recommended seftings)
Yalidate my idertiy 25 follows:

I Il

I | futematicallyuse my windaws lagor name znd
passiord (and dama if any]

I™ | Reguire data enciyption (discanest if none)

@ Advanced [custom settings]

Using these sellings 1equires a knowledge g i
of security pratocols

Cancel
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4. 'This will bring up the Advanced Security Settings dialog box. From here you can
configure Client-1’s VPN security settings.  Just like the VPN server, Microsoft
encrypted authentication version 2 (MS-CHAP v2) and Microsoft encrypted
authentication (MS-CHAP) are enabled by default. Un-check MS-CHAP v2 and leave
MS-CHAP checked, as the only authentication protocol that Client-1 will use for
authentication.  Click OK and OK again on the Security tab to complete the
configuration.

Advanced Security Settings E 21

Data sncyption

~Logan secui
' Uss Extensible Authentication Protacal (EAP]

IE|
Properties
* Allow these protocols
I~ Unercrypted password [PAP)
I~ Shiva Password Authentication Protocal [SPAP)

I~ Challenge Handshake Avthentication Pratocal [CHAP)
IV Miciosaft CHAP [M5-CHAP)
‘Allow cider MS-CHAF version for Windaws 95 servers

I Microsoft CHAP Version 2 [MS-CHAP v2)

I~ For M5-CHAP based protocaks, automaticall use my
Windows lagen name and password (and domain if any)

Cancel

5. You can now test the interaction between SRV-1 and Client-1 using different
authentication protocols. From Client-1, type in jstacey as the user name, mega as the
password and click Connect to try to establish a VPN session. You should immediately
get an error message. This error message indicates that SRV-1 refused the connection
based on a non-matching authentication protocol. In order to establish a VPN session
successfully, you will have to enable MS-CHAP v2 on Client-1 and reconnect to the
VPN server.

Error Connecting to Virtual Private Eunnect: |

& Werifying uzername and password...

Error 915: The remote computer refused to be authenticated using
the configured authentication protocol. The line has been
disconnected,

| Redial = 43 I Canhicel Maore Info
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L.ab 2

Configuring a Virtual Private Network for
Green Lizard Books, Inc. using the
Layer Two Tunneling Protocol (L2TP)

You will learn how to:

e Install Certificate Services
e Install machine certificates on a VPN server and client
e Configure a VPN server to accept L2TP connections

e LEstablish a VPN session using L2TP
e Monitor security on the link using ipsecmon
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Scenario

The VPN you setup for Green Lizard has been working fantastically. There have been no
complaints from anybody and the users are impressed with the reliability and speed that their
new solution offers them. Bill, the owner of Green Lizard, is even happier. His long
distance phone bill charges have been cut drastically, and he has already recouped the
investment he made in the new solution. The reason that you approach Bill today is to talk
about security. Bill has been burnt once before for his lack of concern over the issue, so he
is all ears. You spare him the technical details, but inform him that you have been doing
some research on Microsoft’s VPN offerings, and that you think that Green Lizard would be
more secure if they used a different type of VPN. You ensure him that although current
VPN connections are encrypted and secure with Point-to-Point Tunneling Protocol (PPTP),
you are able to increase security even further for little to no additional cost. Your plan is to
switch Green Lizard’s current PPTP VPN setup to a solution that supports L2TP
exclusively. L2TP is a joint venture that takes the best features of Microsoft’s PPTP and
combines them with Cisco’s Layer Two Forwarding (L2F) to produce a more functional,
secure and standardized protocol. The major differences between the two protocols are
listed below:

PPTP L2TP

Supported Windows 9x, NT 4.0, ME, Windows 2000, XP/2003 and
Operating Systems | Windows 2000, Windows XP, | NT4/98/ME (with the

Windows 2003, UNIX L2TP/IPSec VPN client installed)
NAT Windows 2000 PPTP — Yes Windows 2000 L2TP VPNS — No
Compatibility Windows 2003 PPTP — Yes Windows 2003 L2TP VPNS - Yes
User Point-to-Point-Protocol (PPP) | Point-to-Point-Protocol (PPP)
Authentication
Encryption MS Point-to-Point (MPPE) IPSec
Certificate Services | Not Necessary Required
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In this lab, you will modify your PPTP VPN server so that it will only support the more
secure L2TP. In order for L2TP to work, you will need to install certificate services and
then manually install machine certificates on both your VPN server and client.  After the
setup is complete, you will modify the VPN server to accept L2TP connections as well as
make the necessary changes to the VPN client.

Certificate Services

Certificate Services allow information to be exchanged securely both on the Internet and
within private networks through the use of PKI (Public Key Infrastructure) technology.
PKI uses a pair of keys, a public encryption key and a private encryption key, to verify
the identity of systems. A private encryption key always stays protected on the local
client or server. The public encryption key, on the other hand, is distributed freely so
others can engage in encrypted communication with the local machine. Certificate
Servers, also known as Certificate Authorities (CAs), distribute keys by issuing
certificates which contain the public key to the requesting clients.

Installing Certificate Services

In order for L2TP VPN sessions to work properly, you will have to install machine
certificates on both your VPN server and client. These will be obtained from a local
Certificate Server on Green Lizard’s network.

1. Log on to SRV-11 and go to Start->Settings=>Control Panel. Double click on the
Add/Remove Programs icon and click on Add/Remove Windows Components on
the left column. This will bring up the Windows Components Wizard. Place a check
mark in the box next to Certificate Services and click Next to continue.

Windows Components Wizard 5[
Windows Components o
‘Yo can add or remove components of Windowes 2000, :i

To add or remove a component, click the checkbox A shaded box means that only
part of the comporent will be installed. To see what's included in a component, click.
Details.

Companents

[ Accessories and Utlties

(M [ Certificate Services

[] <> Cluster Service

25MB

P Indexing Service 0.0ME

[ 5B Internet Infrmatinn Servines 11151 22 NMA LI

Description:  Installs a cerification autharity (CA) to issue certificates for use with
public key securty applications.

Tatal disk space requ!ired: 0.9 ME Detais |

Space available on disk: 23229 MB

¢ Back I Next > I Cancel |
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2. You will receive a message warning you that the server cannot be renamed or its domain
membership has changed after the Certificate Services installation. Just click Yes to
continue.

Microsoft Certificate Services |

After installing Certificate Services, the computer cannot be renamed and the computer cannot join or be removed
from a domain. Do you want ko continue?

Yes Mo |

3. The next screen will give you 4 different Certification Authority types (Enterprise root
CA, Enterprise subordinate CA, Stand-alone root CA and Stand-alone subordinate CA)
to choose from. Certificates will only be distributed to users and computers within
Green Lizard, so you will select Enterprise root CA and click Next to continue.

E
Certification Authority Type T
There are four types of certification autharitiss, 3

Certification Authority types: Description

The most tusted CA in an
enterprise. Should be installed
before ary ot CA, Requitss
|Active Directary,

¥ Enterprise oot CA
" Enterprise subordinate C4
" Stand-alone oot CA

€ Stand-alone subordinats C&

Kl

™ Advanced options

<Back [ Mewt> p]  Concel |

4. 'This will bring you to the CA Identifying Information screen. Fill this form out with all
of the required information - don’t worry about completeness or accuracy of
information for this lab. Click Next to continue.

=
CA Identifying Information i

Entter information ta identify this CA a
Cd name: I\;PN
Organization IGleen Lizard Books Inc.
Organizational unit: IHeadqualtels
City: IEh\:ago
State or province: l”‘— Country/region Ir
E-mail Isuupult@gleenlizaldbuuks.cum
CA description: IEemh:ate for PN clients
Walid for. |2 |sz =] Evpires |s/17/2uu5 5:52 P

< Back I ezt > I:I Cancel
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5. On the Data Storage Location screen, just confirm the certificate database location and
click Next.

Windows Components Wizard

Data Storage Location
Specify the storage location for the configuration deta. database and log

Certificate database:

Browse...

Cetificate database log

[EANNTS pstena Cont og Browse..
I Store configuration information in a shared folder

Shared folder:

| Brawse

™ Fresee exsting cerfificate database:

< Back I Next > F I Cancel

6. The installation takes about 5-10 minutes. You will eventually get a screen letting you
know that the installation is done. Click on Finish to complete the installation.

windows Components Wizard

Configuring Companents
Setupis making the configuration changss you requested

. Please wait while Setup configures the companents. This may take
[Jfe¥  several minutes, depending on the camy ts select
e . depending ponents selecle

Status: Completing configuration of Certificate Services..

I —

< Back Nest>

7. To open Certificate Services, just go to Start>Programs—>Administrative
Tools=>Certification Authority. As you can see, VPN, the Enterprise root CA that
you named in the last step, is ready to issue certificates. Reboot SRV-11 once you have
verified the installation of Certificate Services.

[ Certification Authority o ] S

| acion vew || & » | Bm | FRB 2] > = |

Tree I Marne I

Certification Autharity (Local) (IRevoked Certificates

@ [[Issued Certificates

[[dPending Requests
[Failed Requests
[(APalicy Settings
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Installing machine certificates on both of your VPN server and client

There are several methods of installing certificates onto computers, including: automatic
deployment, manual certificate deployment and Internet based deployment. For the
purposes of this lab, you will install certificates manually.

1. Before you can install a machine certificate on Client-1, you will have to connect Client-1
directly to Green Lizard’s private LAN. To accomplish this, just plug Client-1’s
network cable into the private LAN hub/switch, and change its static IP address
from 15.15.15.20 with 255.0.0.0 subnet mask to 192.168.1.2 with 255.255.255.0 subnet
mask. Also, configure the preferred DNS server setting to point to SRV-11, 192.168.1.1
and leave the alternate DNS setting blank. The default gateway should also now change
to point to the private side of SRV-1, 192.168.1.201. You are now ready to install a
certificate on Client-1.

***Important Note***

Reassigning Client-1’s IP address is only temporary, in order to install the certificate without any
problems. At the end of this procedure, Client-1’s IP address will be re-assigned the IP address
information it used originally.

Client Certificate Installation

1. Log on to Client-1 as the administrator, go to Start=>Run, type in mmc and click OK
to open the Microsoft Management Console (MMC).

el |

Tvpe the nare of a pragram, Folder, document, o
Internet resource, and Windows will open it for wou,

OK‘E I Cancel | Browse. .. |
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from the menu.

3. In this Add/Remove Snap-in screen, just click Add and you will see thete are many
Snap-ins available for you to add. Select Certificates to be the Standalone Snap-in and

i Console1 - [Console Root]

|G| console windaw  Help

=101 %]

b o w2

ctro

D= -lex
|

s

Rezent File

Exit

Mame, |

click Add to continue.

4. 'This will bring you to the Certificates snap-in dialog box. From here you can control
what type of certificates will be managed within the Certificates snap-in. Since you will
be installing a machine certificate on Client-1, you will want this snap-in to manage
certificates for computer accounts. Therefore, just select Computer account and click

Next.
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Al Remave Snag-in = B k3| | ndd Standalone Snap-in x|
Standekns | Estrnsons | Available Standalons Snapins
2 arcler Snapin | Wendar [
; pe Activeid Control
S added o j-_]m -I [ ] S‘\ﬁ
_I Microzoft Corporation
Micrasaft Corporation
Microsoft Coporation —J
=) Computer Management Micrsalt Corporation
Dievice Manager Microsoit Corparation
I Disk Dehragmenter Executive Software Inte..
(1Disk Managsment WERITAS Software Cor.
Evvert Viewsr Microsoft Corporation
(85 Fax Service Managsment Microsolt Coporation o |
Descition - Desciiption
The Cettficates snap-in allows you to browse the contents of the
cetificate stores for poursel, a service, or a computer,
a1 T |
.
Crce o1y ] oo |

Certificates snap-in

This snap-in will always manage certficates for
€ My user accaunt
 Service sccount

% Computer account

< Back I Nexl>£| Caricel
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5. Within the Select Computer screen, you will need to select a computer for this snap-in to
manage. You can either choose the local computer or another computer on your
network. Since you only want this snap-in to manage Client-1, the local computer, you
will select Local computer. Click Finish to close this screen. Then click Close in the
Add Standalone snap-in window.

Select Computer x|

Select the computer pou want thiz Snap-in to manage,

This snap-in will always manage:

' Local computer: (the computer this console is rnning o) <:|
 Anather computer: I Browse... |

[~ Allow the selscted computer to be changed when launching from the command line. This
only applies if you save the consale.

< Back I Finish ‘E I Cancel

6. Next, verify that the Certificates (Local Computer) Snap-in has been added to the
Console Root and click OK to close this Add/Remove Snap-in window.

Add/Remove Snap-in ﬂll

Standalone | Extensions I

Uze thiz page to add or remove a standalone Snap-in from the console.

Snap-ing added to: Ia Conzole Roat j

@ Certificates [Local Computer)

r— Description

Add... Remayve Sbout... |

oK %J Cancel
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Initiating a new Certificate request through the Certificates snap-in

1. Double click Certificates (Local Computer) under the Console Root in the left pane.
It will bring you all of the certificate categories for Client-1. Next, select the Personal
folder and then select Action=>All Tasks>Request New Certificate from the menu

above.
] Cansole Root T Consotel - [Console Foot\articaes (SN CR R EEE BEE
: i By Qome ko iy NS\ @ -lalx
= pcal Computer) e e e T Ty
1 Fd Ceetificates. .. i
B " __ Find Certificatas...
Foot Certification Authorities S —— mr
i [
-] Enterprise Trust rd“
i ] o Arkhorbes
CI Intermediate Certification Sutharities :‘"""‘ L
w0 5PC
‘| »

Flaquest & v personsl certficate

2. This will bring up the Certificate Request Wizard, click Next to continue. If this fails,
reboot your computer and attempt to start the wizard again.

Certificate Request Wizard x|

Welcome to the Certificate
Request Wizard

This wizard helps vou request a new certificate fram a
certification authority (CA) in your domain.

A certificate, which is issued by a certification authaority,
is a confirmation of your identity and contains
information used to protect data or to establish secure
network connections,

A private key is the secret half of a public and private
key pair associated with a certificate, It is used ka
digitally sign or decrypt data encrypted with the
carresponding public key,

To continue, chick Mext.

= Back I Next = ‘E I Cancel
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3. From within the Certificate Template page, you can select different certificate
templates. Since you specified “computer account” earlier, the only template you will
see is for computers. Highlight the Computer template and select the Advanced
options checkbox. Click Next to continue.

Certificate Request Wizard x|

Certificate Template
A certificate template contains preset properky values For certificates,

Select a certificate template For your request.

Certificate templates:

V¥ advanced options

< Back I Mezxt >.E I Cancel

4. 'The Cryptographic Service Provider screen allows you to choose what type of algorithm
to use in conjunction with your certificates. This can be adjusted based on security
needs and other preferences. The default algorithm is fine, so leave Microsoft RSA
Schannel Cryptographic Provide selected and click Next to continue.

Certificate Request Wizard x|

Cryptographic Service Provider

& crypkographic service provider (CSP) generates public and private key pairs For the
encryption and decryption of messages.

Individual C5Ps may have different cryptographic algorithms that pravide various
levels of security,

Select the CSP you want ko use with this certificate,

Cryptographic service providers:

Gemplus GemSAFE Card CSP 1.0 -

Micrasoft Base Cryptographic Provider w1.0

Microsoft Base DSS and Diffie-Hellman Cryptographic Provider

Microsoft Base DSS Cryptographic Provider

[l Ft D annel Cryptagraphic Pr
& Sphi

al

I | Enable sbtong private key. protection, Youwill be prampted every bme the
private key is used by an application if wou enable this option,

< Back I MNext = [: I Cancel
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5. The Certificate Request Wizard then allows you to choose which Certificate Authority to
send your request to. VPN, the enterprise root CA you installed earlier on SRV-11,
should be highlighted. Click Next to continue.

Certificate Request Wizard x|

Certification Authority
The certificate request is sent to the CA you select,

Ch:

WP Browse... |

Computer:

I Srv-11.greenlizardbooks, com

< Back I Mext = |: I Cancel

6. This brings up the Certificate Friendly Name and Description screen where you can type
in a friendly name and description to identify this certificate. The friendly name is locally
significant to your computer and allows you to identify the purpose of the certificate on
the local computer. Click Next to continue.

Certificate Request Wizard x|

Certificate Friendly Name and Description

‘fou can provide a name and description that help you quickly identify a specific
certificate,

Type a friendly name and description For the new certificate,
Friendly name:

LETP <l:|

Description:

WPN with LZTP <

< Back I ek = ‘E I Cancel
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7. On the last screen of the wizard, verify all of the settings that you have specified. Click
Finish and you will have completed the certificate request.

rerticate Requmtwirand ]

Completing the Certificate
Reguest Wizard

Yeu have puccessfuly completed the Cerificte
Pinquest woard,

Frimeaky N LITR

Cummguter Name: CLIENT-1

Cretification futhorky VPN

Cortficate Tomplote  Computer

(=] Microsolt A SChannel Crygee

8. The wizard should then report a successful certificate request. Just click OK to close this

dialog box.
Certificate Request Wizar x|
@ The certificate request was successful,

9. You should now confirm the receipt of this certificate. In the Certificates snap-in,
double click Certificates (Local Computer) under Console Root in the left pane,
double click the Personal folder and click on the Certificates folder. As you see in the
right pane, you can view information about this certificate. You can also view this
information by double clicking on the certificate. Double clicking the certificate will
bring up the Certificate dialog box and provide you with information about this

certificate.

Tree I Favorites | Issued To # | Issued B | Expiration Date | Intended Purposes | Friendly Mame | Stakus |
(_1 Console Root = |Elclient-1.greenlizardbonks com WP 611712004 Client Authentication, Server Authentication  L2TP
E@ Certificates (Local Ce

B[22 Personal

= Certificates

[:l Trusted Root Cer+
«| | »

ertiate 2

Gererdl | Detats | Certhication path |

1‘:‘:} Certificate Information

This eertificat e bs intended bo:

SProves pour kentity bo & remote computer
sErrrs the identity of a remote comguter

Tssuedtne Chent-| grennkardbocks. com
Tsued bz VPN

Walid Frowv £/18[2003 bo #{17/7004

T¥ Viou have & guivake hay that coresponds bo ths certiicate.

il
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10. You now have successfully installed a machine certificate on Client-1, your VPN client.
Make sure that you reboot Client-1 to avoid any unforeseen problems. On SRV-1, your
VPN server, you will install a certificate the same way by following the above

Don’t forget to restart SRV-1 after you have completed the certificate

request process. After you have finished this step, make sure that you reconnect Client-

1 back to the public side of your network and make sure that all of the IP addresses

are properly assigned as was originally specified. Refer to Computer Configuration

Overview, if you have any questions on this.

procedures.

Establishing a VPN session using L.2TP

VPN Setver setup

In Lab 1, you already setup 5 L2TP portts to be available on the VPN Server. In this lab, you
now want SRV-1, your VPN server, to accept only L2TP connections, so you will want to
disable all of the PPTP ports on SRV-1.

1. To do this, log on to SRV-1, go to Start=>Programs->Administrative Tools and click
on Routing and Remote Access. Right click Ports and select Properties.
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| action  wiew Hc:- B ElENE =N

=10l

Tree I

Ports

E Routing and Remate Access
i{ Server Status
= [fay SRY-1 (local)

Routing Interfaces

0B PR

¥ Rem(  Refresh
B0 Remd Eyprt Lisk..

Help

Remote Access Clients (00

»

Mame

| Device

| Status |

3 waN Miniport (PPTP) (VPNG-9)
%WAN Minipart (PPTP) (YPM3-8)
B3 waN Miniport (PPTP) (VPNG-7)
%WAN Minipart (PPTP) (YPM3-6)
AN Miniport (PPTP) (VPNG-5)
%WAN Minipark (PPTP) (YPM3-4)
AN Miniport (PPTP) (VPNG-3)
%WAN Minipart (PPTP) (YPM3-2)
T WAN Miniport (PPTP) (YPM3-1)
%WAN Minipart (PPTP) (YPM3-0)
%WF\N Miniport (L2TP) (YPMHZ-4)
%WAN Minipark (LZTF) (YPH2-3)
%WF\N Miniport (L2TP) (YPMZ-2)
%WAN Minipark (LZTP) (YPH2-1)
%WF\N Miniport (L2TF) (YPMZ-0)
%D\rect Parallel (LPT1)

WPN
WPN
WPN
WPN
WPN
WPN
WPN
WPN
WPN
WPN
VPN
WPN
VPN
WPN
VPN
PARALLEL

Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive
Inactive

Opens property sheek For the current selection.
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2. This will bring up the Ports Properties dialog box. Again, there are 2 types of VPN
ports, WAN Miniport (PPTP) and WAN Miniport (L2TP).
(PPTP) and click Configure.

Ports Properties ﬂﬂ

Devices |

Fouting and Remate Access [RRAS] uses the devices listed below.

Device

(PPTF)
wish Miniport [L2TF) L2TP
Direct Parallel Flouting Parallel 1

Configure... [: |

QK I Cancel Apply

Select WAN Miniport

3. In the Configure Device — WAN Miniport (PPTP) dialog box, uncheck Remote
access connections (inbound only) and uncheck the Demand-dial routing
connections (inbound and outbound). Click OK and then OK again on the Ports
Properties dialog box to complete the configuration.
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Configure Device - WAN Miniport (PPTP} 21|

You can use this device
connestis

ez requests or demand-dial

Remate access connections (inbound only)

[~ Demand-dial routing connections (inbound and outbound)

ou can et a maximum part linit for a device that supparts multiple ports.

b aximum parts: 10 =i

ak ‘E I Cancel

© Train Signal, Inc., 2002-2003



alrainSIGNAL. ..

4. As you can see from the right pane of the RRAS console, you now have 5 L2TP ports
and no PPTP ports available for your VPN clients to access.

=
| ation vew || & = | AHE|EFRHB @ |

Tree I Parts

E Fouting and Remoke Access Marne % | Device Comment Status | |
-7 Server Status ot AN Miniport (L2TF) (VP24 YPH Inactive
E--% SRY-1 {Jocal) S AN Miniport (L2TP) (WRNZ3)  WEN Inactive
B Routing Interfares S AN Miniport (L2TR) (VPN2-2) PN Inactive
& Remote Access Clients (0) e WA Minipork (LZTP) (WPNZ-13 PN Inactive

= 22 wwn Minipork (L2TP) (VPN2-0) WP Inactive
& 1P Routing = Direct Parallel (LPT1 PARALLEL Inactive

«%S_' Remote Access Policies
D Remote Access Logging

VPN Client setup

5. Log on to Client-1, go to Start=>Settings>Netwotk and Dial-up Connections and
click on the Virtual Private Connection (which will be named whatever you set it at in
the previous lab). This will bring you to the Connect Virtual Private Connection dialog
box again, click on the Properties button and select the Networking tab. Click on the
down arrow and select Layer 2 Tunneling Protocol (L2TP) as the type of the VPN
server you are calling. Click OK to complete the configuration.

el

Yirtual Private Connection

Ganera\l Dpliunsl Securty  Metworking IShanngl

PN zerver | am calling:
2 Turneling Protocal [L2TF)

ettings: |

Components checked are used by this connection:

1P]
File and Printer Sharing for Microsoft Metworks
Client for Microsoft Metworks

Install... Uninztall Properties

r Description

Transmission Control Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected netwarks

Canicel
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6. You are now ready to establish your VPN session using L2TP. From Client-1, just type
in jstacey as the user name and mega as the password in the Connect Virtual Private
Connection dialog box. Click Connect to establish the VPN connection with L2TP.

Connect Yirtual Private Connection

Llser name: |i$taCE_'r'

1
Pazswiord: I"""" Your pazzword is mega

[" Save Pazsword

Connect&l Cancel | Properties | Help |

Monitoring security on the link using ipsecmon

After you have established your VPN session with L2TP, you can use ipsecmon to monitor
the security on the link.

1. To do this, on either your VPN setver or client, go to Start=>Run, type in ipsecmon
and click OK to open the IP Security Monitor. This IP Security Monitor screen
provides you with information about the IPSec relationship between the 2 edges of your
VPN tunnel.

Security Associations:
Policy Mame | Secunty | FiterName | Source Address | Dest Address | Protocol | Src. Pott | Dest, | | Options
L2TF Rule ESPD.. NoMame 15151515 15151520 upp 0 1701 Mirimize:
4] I 13|

IPSEL Statisti ISARMP/Oakley Statist
Active Associations 1 Dakley Main Modes 1
Confidential Bytes Sent 2,861,752 Dakley Quick Modes B4
Carfidential Bytes Received 7476419 Soft Associations o
Authenticated Bytes Sent 3,401,976 Authentication Failures 1}
Authenticated Bytes Received 8,297 836
Bad 5P| Packets 0
Packets Naot Decrypted 1)
Packets Not Authenticated 0
Key Additions B4 IP Security is enabled on this computer. |
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LLab 3

Creating and configuring Remote Access
policies for Green Lizard Books, Inc.

You will learn how to:

e C(reate a Remote Access Policy in Mixed Mode
e Create 2 Remote Access Policy in Native Mode
e Modity the default policy
e Set Remote Access Policy conditions

e Set Remote Access Policy permissions
e Create a Remote Access Policy profile
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Scenario

Now that Green Lizard Books Inc. has a L2TP VPN Server in place for its remote access
clients, you feel a lot more comfortable with the overall security of the remote access
solution. In your weekly meeting with Bill, however, he brings up the issue of having more
control over which of his employees have remote access to Green Lizard’s LAN. He also
mentions that he would like to control how and when these employees connect to the LAN.
“What a great idea - why didn’t I come up with that?” you think to yourself. “Well, right
now,” you say out loud, “the VPN solution has a policy that allows everyone to access the
LAN 24 hours a day/7 days a week, so I will have to look at this a little closer and get back
to you with an adequate solution. In the meantime, I will need for you (Bill) to come up
with a list of users that should be granted remote access and the times that they should be
allowed to connect to the network.” He agrees and you both decide to meet again next
week to discuss how to set policies on the VPN server.

In this lab, you will examine the default state that a VPN server is in when you first enable
remote access on the server. From there, you will learn how to decide which option for
assigning remote access policy best suits your network. Finally, you will create, configure
and implement several different remote access policies and examine how they interact with
the VPN connection.
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RRAS Authentication Process in Mixed Mode

Not available in

mixed mode
There are two dial-in permissions
available to select in Active Allow access If Deny access Control access through remote
Directory user's Dial-in Tab Condtions access

not match
or no RAS
RRAS will evaluate the ﬂ palicy @

components of a RAS policy. exists

There are 3 components consistin | Conditions Denied
a RAS policy: conditians, access
permissions, and profile It

Conditions
match @

RAS policy's permissions will not
be evaluate when Allow access is P
selected in user's Dial-in Tab. Dial-| (Wil notbe
in permissions overrides RAS evaluated)

policy’s permissions U
Profile
If Profile
sattings
met

Access
Allowed

Permissions

If Profile
setflings
not met

RRAS Authentication Process in Native Mode

Control access
There are three dial-in permissions through remote
available to select in Active Allow access If Deny access If access

Directory user's Dial-in Tab Condtions Condtions
not match not match
@ or no RAS @ or no RAS @
RRAS will evaluate the policy palicy
components of a RAS policy. exets Denied SRS
There are 3 components consist in Conditions Conditions
a RAS policy: conditions, access
permissions, and profile If Deny If
Cmdltlons@ remote @ Conditions RAS policy's
match aprenn match permission will

RAS policy's permissions will not m
be evaluated when Allow access is 2

selected in user's Dialin Tab. Dial-| (Wil Not be
in permissions overrides RAS evaluated)

be evaluated
ons when Contral
access through

Per

If Profile

Grant EMole access is
policy's permissions sellings remote selected in
not met f Profile access Active Direclory
settings user'_ls_ E';lal-m
a
rofile righ et Profile

If Profile If Profile
setfings settings
met

met

Access Access
Allowed Allowed
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Reviewing the current remote access permissions

In Lab 1, the remote access permission was granted to allow access to your remote user,
John Stacey. In this lab, you are going to take a closer look at how remote access
permissions and policies interact.

1. Log on to SRV-11 and open the Active Directory Users and Computers console by
going to Start>Programs->Administrative Tools>Active Directory Users and
Computers. In the right pane of console, select John Stacey and double click the user.

Marne I Type I Diescripkion |
ﬂ administrator ser Built-in account For admini, ..
!ﬁCert Publishers  Security Group ... Enterprise certification an...
!ﬁDnsAdmins Security Group ... DS Administrators Group

!ﬁDnsUpdatePr. .. Security Group ... DS clients who are permi...
ﬁDomain Admins  Security Group ... Designated administrators. ..
!ﬁDomain Comp... Security Group .., All workstations and serve, .,

ﬁDomain Contr.., Security Group ... All domain controllers in th,..
ﬁDomain Guests  Security Group ... All domain guests
ﬁDomain Users  Security Group ... Al domain users

ﬁEnterprise ad... Security Group .., Designated administrators..,
!ﬁGmup Palicy ...  Security Group ... Members in this group can...
Guest ser Built-in account For quest ...

| 4 10hn Stacey
%krbtgt User Key Distribution Center Se. ..
gﬁR.ﬂS and IAS ... Securiby Group ... Servers in this group can ...

2. This will bring you to the John Stacey Properties dialog box. Select the Dial-in tab and
notice that it gives you 3 different options you can set for Remote Access Permission:
Allow access, Deny access and Control access through Remote Access Policy. By
default, the last option, Control access through Remote Access Policy, should be grayed
out. This option is not available when your domain is in mixed mode. Later in this lab
you will switch your domain to native mode in order to make this option available.

John Stacey Properties x|

Femats control | Terminal Services Profile
General | Addess | Account | Profile | Telephones | Organization
Member Of Digin | Ervionment | Sessions

- Remal

™ Allow access
" Deny access

£ Corfrollaccess tiough Remote Access Policy

I ey B  —

- Callback Option:
* Mo Callback

€ Set by Caller (Routing and Remote Access Service only)

" Always Callback to:
™| Assign a Static IP Addiess

o Apnly Static Boutes:

Define routes to enable for this Diakin Static Routes ...
connection,

T ok | oo | i |
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In Lab 1, the user account, John Stacey, was allowed remote access by selecting the Allow
access option as John’s remote access permission. But, according to the authentication
process detailed on page 69, the RRAS server will also check to see if a remote access policy
exists, which is exactly how this process works. If there is no remote access policy
configured, John’s access will be denied. By default however, there is a remote access policy
that was automatically created when RRAS was enabled, and it contains a condition that
specifies that anybody can access the VPN Server 24 hours a day, 7 days a week. If this
condition is met, then the policy will check the profile settings before allowing John access
to the VPN server.

Viewing the default RAS policy

1. To view this default RAS policy, log on to SRV-1 and open Routing and Remote
Access by going to Start>Programs—>Administrative Tools>Routing and
Remote Access. In the left pane of the console, click on Remote Access Policies.
This will show all of the remote access policies in the right pane. There should only be
one remote access policy present, named “Allow access if dial-in permission is enabled,”
which is created by default when you enabled RRAS.

REET
J Action  Wiew H o= | |||§ |

Tree I Remoke Access Policies

Routing and Remate Access M—_——_ __—'__“l"@&d;r |

Server Status < A\Inw access F dial-in permission is enabled 1
= [y SRY-1 (localy

E Routing Interfaces
= Remate Access Clisnts (03

B Parts

licies
aging

2. Double click the policy and it will bring you to its properties. From here, notice that
there are 3 components present that make up the remote access policy: Condition(s),
Permission and the Profile

In this default policy, there is only one condition listed. This condition allows users to

access the VPN server from Sunday at 00:00 to the following Saturday at 24:00. In other
words, it allows access all of the time.
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3. The next component is the permission, which you can set to either grant or deny access
to the remote user, if the user matches the initial conditions. Although it is currently set
at deny access, the permission of this RAS policy will NOT be under consideration,
because you have selected Allow access as John Stacey’s dial-in permission within Active
Directory. In other words, according to the RRAS authentication process, the uset’s
dial-in permission overrides the permission set within the RAS policy and the only time
this permission will be considered is when the user’s dial-in permission is set to “Control
access through Remote Access Policy.”

The profile is the last component of a RAS policy. It contains 6 tabs with many
configurable settings. We will go into each tab in great detail later in this lab.

allow access if dial-in permission is enabled P 2xl

Settings

Palicy name:

Conditions

Add I Remove I Edit I

rIF a user matches the condition:

{” Grant remote access permission
. Permissions
{* Deny remote access pemission
Access wil be denied. The profile you spécify will be ignared

unless aocess is overnidden on a per-user basis.

Edit Profile... | < Profile

ak I Cancel | Apply
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Switching to Native Mode

In order to have the third option, “Control access through Remote Access Policy,” available
on John Stacey’s Dial-in tab, you will have to switch the domain mode from the default
mixed mode to native mode. Mixed mode supports both Windows 2000 and NT 4 domain
controllers. Once your domain is switched to Native mode, NT 4 domain controllers will
no longer be supported. Also, even though NT 4 domain controllers may have never
existed within your domain, your domain will still default to mixed mode and you are
required to manually make the switch from mixed mode to native mode. Once you make
the switch from mixed mode to native mode you can not go back without completely wiping
out your Active Directory and starting from scratch.

Green Lizard’s network only contains a Windows 2000 domain controller and they have no
future plans on adding a NT 4 domain controller, so they can make the switch to native
mode without any problems.

1. Log on to SRV-11 and open the Active Directory Domains and Trusts console by
going to Start>Programs—>Administrative Tools—>Active Directory Domains and
Trusts.

ains and Trusts
ﬁ Active Directory Sites and Services

@ Active Directary Users and Computers
r%] Component Services

Q Zomputer Management
Configure Your Server

Diata Sources (ODBC)

.E Distributed File System
A

@ Domain Controller Security Policy
@ Domain Security Policy

Event Yiewsr

% Licensing

@ Local Security Policy

@ Petformance

E Routing and Remate Access

% Services

gﬂ Telnet Server Administration

@l Certification Authaority

2. In the left pane of the console, right click on greenlizardbooks.com and choose
Properties.

=10l x|
J fckion  View |J &= -’||||g) |

Tree I Mame: | Tvpe |

Active Direckary Dormains and Trusts
greenlizardbooks. com

Manage
View 3

Export Lisk. ..

e

‘Opens property sheet for the current selection, |
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3. This will bring you to the greenlizardbooks.com properties dialog box. As you see, your
domain is currently in mixed mode. In order for you to switch to the native mode, just
click the Change Mode button.

greenlizardbooks.com Properties 2 x|

General | Trusts | Managed By |

@ areenlizardbaoks.com

Domain name (pre-windows 2000)

Desciiption

Domair Gperation mode

Mized mode [supports both Windows 2000 and pre-Windows 2000 domain
contrallers).

Domain mod;

@ To change the domain ta native made. click Change Maode.
Thiz operation cannot be reversed. For more information about

domain modes, see Help.
Change Maode [

0K | Cameel | e |

4. You will get a message warning you that the domain will not be able to be reset to mixed
mode after this operation. Just click Yes to continue.

Active Directory |

Are vou sure you want ko change this domain to native moder After this operation is
completed, the domain cannat be reset to mixed mode,

s Mo |

5. Click OK in the greenlizardbooks.com properties dialog box and also click OK in the
confirmation message box to complete the operation. Also, it is a really good idea to

restart your computer to avoid any unexpected potential problems after changing the
domain mode.

Active Directory il

@ The operation has completed successfully, It may take 15 minutes ar more Far this information to replicate to all

dornain controllers,
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6. Once your system has rebooted, log back on to SRV-11 and open the Active Directory

Users and Computers console by going to Start>Programs—>Administrative
Tools—>Active Directory Users and Computers. In the right pane of console, select
John Stacey and double click the object. Select the Dial-in tab again. Notice, that the
third option is now available to select. Select Control Access through Remote Access
Policy and click OK. You will be using this remote access permission to examine the
RAS policy in the next section.

John Stacey Properties 2l

Remote control | Terminal Services Profile |
Generl | Address | Account | Profie | Telephones | Diganization |
Member OF Diakin Emviorment | Sessions

~Remate Access Permission [Dialin or VPN)
 Allow access

' Deny access

& Control access tuaugh Remote Access Palicy <
I™ Veiify CallerID:

~ Callback Optiare
& NoCalback

" Set by Caller [Roufing and Remote Access Service onl)

€ Aways Callback to
[ Assign a Stalic [P Address —

T Apply Static Routes

Define routes ta enable for this Diakin Static Routes ..
connection

Exveel Apply

Examining the remote access policy

Log on to Client-1, go to Start>Settings—>Network and Dial-up Connections and
click on the Virtual Private Connection. This will bring you to the Connect Virtual
Private Connection dialog box again, just type in jstacey as the user name and mega as
the password and try to establish the VPN connection by clicking the Connect button.
You will immediately get an error message indicating that John’s account does not have
permission to dial in. Remote access has been denied. This is due to the setting you
changed in the last step when you selected “Control access through Remote Access
Policy” from John’s Dial-in tab. The permission from the default remote access policy is
now being evaluated, and, as was pointed out in an earlier step, the permission of the
default remote access policy is currently set for deny access. Therefore, John’s access
has been denied.

Error Connecting to ¥irtual Private Conne 2|

& Werifying uzermname and pagzword...

Ermar B49: The account does not have permizsion to dial in.

I Fedial = 36 | cancel More Info
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2. To modify the default remote access policy, log back on to SRV-1 and open Routing
and Remote Access by going to Start > Programs => Administrative Tools =
Routing and Remote Access. Double click the default remote access policy, which
will bring you to its properties. Select Grant remote access permission as the
permission of this RAS policy and click Apply. After waiting a few seconds, you should
now be able to establish a VPN connection from Client-1.

Conditions

1. Next, take a closer look at the remote access policy itself. First, start with understanding
the conditions. The conditions are the first part of the remote access policy that is
checked when a VPN client attempts to access a VPN server. If no condition is
matched or no conditions exist, the VPN client is immediately denied access without any
further consideration. The top portion of the interface shown below is used to edit
current conditions or to add new ones. Click on the Edit button to modify the default

condition.
Allow access if dial-in permission is enabled P 21xl
Settings
Policy name: Allows access if diakin permission is enabled

ohs matches 'Sun 00:00-24:00: kaon 00:00-24:00;

KO B
bdd.. | Remove [[ Edt. | <::|
i~ IF & uzer mal tion:

¢ Grant remote access permission
" Deny remote access peimission

Access will be granted with the profile you specify, unless access
is overidden on a per-user basis.

Edit Profils... |

QK Cancel | Lipply hl
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2. This will bring up the Time of day constraints dialog box. As you see, the default
condition is set for 24/7 access. You can modify the day and the time to allow access.
Below, the schedule has been modified to allow access from 8:00 a.m. to 5:00 p.m. on
weekdays. As you see from the system clock, the time is now way past 5:00 p.m. on
Thursday. Because this condition is not matched, the VPN client will be denied access
to the VPN server once again. You can test this condition by setting different days and
times. Don’t forget to change this condition back to 24/7 access (the default setting)
after you finish testing.

A o ——
g BN S €[ o] -
122+ 4-B-B-10-12- 2+ 4+ 6 §-10-12 3 I'l 2003 :’
A | PRI AAPOR A e
Sunday g
o 1 2 3 4 5 6 7 ER
anday :
— I remiees 89 10 11 12 13 14 ]
Y |’ ~ 15 16 17 18 19 20 21 +
Denied -,
Walesiky 22 23 24 27 28 - o
Thursday Allovy access on Monday to Friday 29 30 o
Friday between 5:00 a.m. to 5:00 p.m, Imﬁ
Saturday
Current time zone: Central Daylight Time

Error Connecting to Yirtual Private Connection A |

& Yerifying uzername and password...

Error B49; The account does not have permission to dial in,

[ Fiedial =% | cancel | Moelnio |

3. From within the Default remote access policy, the policy name can be changed to
something that is meaningful on the network. You can also add multiple conditions to
the remote access policy. Adding multiple conditions requires the VPN client to match
ALL of the conditions that are present within the remote access policy. To add
additional conditions, just click on the Add button.

T
Salllngsl
Specily the condtions to matd
K — 0|
Add..&l Remove | Ed

~If a user matches the
= Grant remote access pemission
" Deny remote access pemission

Access wil be granted with the profile you specily, urless access
is overidden on a per-user basis

Edit Profile.

ok Cancel Apply

Page 77 of 112 © Train Signal, Inc., 2002-2003



i
alrainSIGNAL. ..

4. Clicking on the Add button brings you to the Select Attribute dialog box. There are
many attributes listed but most of them are related to IAS (RADIUS), which you have
not configured in this lab. You will specify a tunneling protocol to be used as a second
condition for this RAS policy. Just select Tunnel Type and click Add.

Windows-Groups is another common condition. Windows-Groups allows you to select
specific group/groups for which you want to restrict or allow access. Do not select this
condition right now.

Select the type of attribute to add, and then click the Add button.
Attribute tpes:
M ame I Description
Called-Station-1d Phane number disled by user
Calling-Stationd Phane number from which call originated
Client-Friendly-Mame Friendly name for the RADIUS client. (145 only]
Client-IP-&ddress IP address of RADIUS client. [|A5 only]
Clientendor Manufacturer of BADIUS prosy or MAS. [IAS onl
Day-And-Time-Restic. .. Time periods and days of week during which use
Framed-Pratocol The protocal to be used
MAS-Identifier String identifying the MAS originating the request
NAS-IP-Address IP address of the NAS originating the request (12
NAS-Port-Type Type of physical port used by the NAS originatin
Type of service user has requested
Tunneling protocals to be uzed
Windows groups that user belongs to
4 | o
Add. Cancel

5. In the Tunnel Type dialog box, there are many different types of tunneling protocols to
choose from. Select Point-to-Point Tunneling Protocol (PPTP), and then click the
Add button and the OK button to add this protocol as the required tunnel type for the

second condition.
MW 21|
Avallable types: Selected tipes

Bay Dial Vitual Service | | Add 35 I Eﬂzt—-t—o-PointTunrleirEP/_)

Generic Route Encaps
<< Remove |

IP Authentication Heat
IP Encapzulating Secu
IP-in-IF Encapsulation
IP-ir-IP Tunneling
Laper Two Fomwarding
Layer Two Turneling F
Minimal IP-inF Encap:
Yirtual Tunneling Prato

o |
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6. There are now two conditions within the default remote access policy and more can be
added if desired. Just remember, your remote users will have to meet all of the
conditions to gain access to the network. For this lab, the VPN client must meet the
24/7 condition (log on anytime) and also be using Point-to-Point Tunneling Protocol
(PPTP) as the tunneling protocol for connection.

allow access if dial-in permission is enabled Pra 2lx|
Settings
Palicy name: Allow acoess if dialin permizsion iz enabled

y the conditions ta match:
D ay-And-

00-24:00;
PTP)"

Add Remove |  Edi

i If & user matches the condition:

% Grant remote access pemmission
€ Deny remote access pemission

Access will be granted with the profile you specify, unless access
is overmdden on a per-user basis.

Edit Prafile

oK I Cancel | Anply I\l

7. In Lab 2, you configured Client-1 to use Layer 2 Tunneling Protocol (L2TP) as the
tunneling protocol. Assuming that this configuration is still in place, try to gain access to
Green Lizard’s network by using the VPN connection on Client-1. Once again, access
should be denied, because Client-1 did not meet all of the conditions (Tunnel-Type
should be PPTP) set forth in the default remote access policy. If you remove the
Tunnel-Type condition Client-1 should be able to establish the VPN connection.

¥irtual Private Connection

2=

Ganerall Dptlﬂnsl Security  Metworking I Shanngl

PN server | am calling:

CPAP)
aring for Microzoft Metwarks
lient for Microsoft Metworks

Error Connecting to Yirtual Private Connec e |

st Urinstal Poperies |

Werifying username and pazsword...
Description

Transmission Cantral Pratocol/ nternet Protocal. The default Error 649; The account does not have DE—'I’ITIiSSiCln ta dial in.
wide area network. pratocal that pravides communication

across diverse interconnected networks.

“Bedial = | Ccancel Mare Info

Cancel
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Permissions

Permissions are the second component of a remote access policy. There are two
permissions to choose in this component: Grant access remote permission and Deny
remote access permission. Again, the permissions in a remote access policy will only be
evaluated when the user’s dial-in permission in Active Directory is set to Control access
through remote access policy and all of the conditions are matched. In this lab, as you
remember, John Stacey’s dial-in permission is currently set to Control access through remote
access policy. Permissions will be evaluated if the condition is matched

Policy name: llows access if diskin permission is enabled

Specify the canditions ta match:

sdd. | Remave |[ Ear |

[ Ifa user hogth

< * Grant remote access permission
" Deny remote access pemission
Access WlGe gramted with the profils you specify, unless access

is overridden on & per-user basis.

Edit Profile.

Profiles

The Profile is the third component of a remote access policy. The profile is checked once
the remote user has met the conditions of the policy AND has been granted remote access
permission (refer back to the diagram at the beginning of this lab). The profile is where you
can fine tune your remote access policy and configure more advanced settings.

1. To configure the profile, just click on the Edit Profile button from within the default
remote access policy properties dialog box.

Allow access if dial-in permission is enabled P 21

Seltings |

Palicy hame:

bod. | Remoe | Edt

- If a user matches the
* Grant remote access permission
" Deny remote access pemission

Access wil be granted with the profils you specily, unless access
is verridden on  per-user basis

Edit Profile. [

0K I Cancel Apply
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2. This will bring you to the Edit Dial-in Profile dialog box. As you can see, there are 6
tabs (Dial-in Constraints, IP, Multilink, Authentication, Encryption and Advanced)
available with many settings for you to configure.

The first tab is the Dial-in Constraints tab. This tab allows you to configure many dial-in
restrictions such as the amount of idle time allowed, the maximum remote access session
time allowed, the days and time specified for remote access (this setting is the same as
the day and time restrictions setting available as the condition), the incoming telephone
number allowed and Dial-in media types. No restrictions are set, by default, from the
dial-in constraint tab.

fFi et 2=l

fatheencaton | Enengion | Advanced
Diskin Conatiants | ® | Musiek

™ Disconnsct ¥ ide foe | j;. mn
I Foutrict s seson b lﬁ mn.

[ Peatrict access to the bolowing days and fmes

T
T Rimstiet Diskin b this i ey [

T~ st Diokin mecka
CIADSLEMT - Asymmstic DL Discrshe biki-Tone ﬂ
CIADSLLAR - Asyerenstse: DL Commrlecs fuspilude Frussn M
DI Ethemet
CII0EL - 1SOM Digptal Subrcribes Lirm
CISD5L - Symmetic DEL =]

[Con ] _cmeat | oo |

3. The next tab is the IP tab. This tab allows you to configure client IP Address
Assignment Policy and IP packet filters. The default IP Address Assignment Policy is
set on Server settings define policy. This means that the RRAS server settings will
define how IP addresses are assigned. In this lab, the RRAS server will assign IP address
from a static address pool. For IP packet filters settings, you can configure separate
filters for inbound (from client) or outbound (to client) data packets.

Edit Dial-in Profile 2=l
Authertication | Encryption | Advanced |
Diakin Conshaints [ | ik

Define the IP addiess assignment policy for the Routing and Femote
Access

~IP Address Assignment Poli

€ Server must supply an IP addiess
' Client may request an [P address

% Server satlings define policy

Define IF* packet flers to apply during this connection.
[Routing and Remote Access oniy)

r~IP Packet Filter

Frorn client.. To cliert,

ok | cancel Appl)
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The third tab is the Multilink tab. This tab allows you to configure Multilink and
Bandwidth Allocation Protocol (BAP). The default Multilink Setting is Default to
server settings. Note: Multilink is a feature that allows remote users with multiple
modems to connect to a multilink enabled RRAS server to improve speed performance.

For Bandwidth Allocation Protocol (BAP) settings, you can configure a couple of
options, including one to disconnect a line if the capacity of the multilink connection
falls below a certain level for a given length of time that you define.

Edit Dial-in Profile 2=
Authentication | Eneiyption | Advanced |
Dialin Constraints | IP Mullink
~ Multlink Setling:

' Default to server seftings
" Disable mukink [festict client to single part)
€ Allaw Multlink:

Linit masimum ports 1 =

—~ Banduidth Allocation Frotocol (BAF) Settings

Reduce a mulilink connection by one line if the lines fall below:

= %ofcapaciyforapeiodof |2 Hrin =

50

™ Requie BAF for dynamic Muliink requests

ok | cencel | ei |

The forth tab is the Authentication tab. This tab allows you to define the type of
authentication that is allowed for remote access. MS-CHAP versions 1 and 2 are
enabled by default. Note that MS-CHAP v2 is the most secure authentication protocol
and is a recommended protocol if your dial-up clients are running Windows 2000 or
your VPN clients are running Windows 2000, Windows NT 4.0 or Windows 98.
Remember that any protocols that you enable in this tab also need to be enabled in the
RRAS server properties.

in Profile x|
Diahin Constraints | P | Multilink |
Autentioaton | Encoption | Advanced

Check the authentication methods which are allowed for this connection.

Extensible Authentication Protaccl
Select the EAP type which s acoaptable for this policy

Smart Card or other Certiicate =1 | Corfigue..

IV Microsoft Encrypted Authentication version 2 (MS-CHAF v2)

IV Microsoft Encrypted Authentication [MS-CHAF)
™ Encrypted duthentication [CHAP)
I~ Unencrypted Authertication (PAP, SPAP]

U
[ Allow remote PPP clisnts o cannect withoL negoliating
any authentication method

0K | Gancel Ll
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6. The fifth tab is the Encryption tab. This tab allows you to define the types of encryption
that are required for the remote user to connect. There are 4 levels of encryption: No
Encryption, Basic, Strong and Strongest. If there is more than one level of encryption
enabled, your RRAS Server will use the most secure encryption that is supported by both
your RRAS server and your remote user.

MOTE: These encruption settings apply only to the Windows 2000 Routing
and Remote Access Service.

Select the levels) of enciyption that should be allowed by this profile,
¥ No Ercryption

¥ Basic

¥ Shong

¥ Shongest

ak I Cancel I Apply |

Edit Dial-in Profile |
Dial-in Constraints | IP | bl altilirns I
Authentication Encryption I Advanced

7. 'The last tab is the Advanced tab. This tab allows you to add connection attributes,
include generic RADIUS attributes and many different vendor-specific attributes.
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Edit Dial-in Profile |
Dial-in Constraints | IP | Mulkilirk, |
Authentication | Enciyption Advanced
Specify additional connection attibutes to be retuined to the Remote
Aocess Server
Parameters:
Mame | Wendor | Value
Service-Type R&DIUS Standard  Framed
Framed-Pratocal RADIUS Standard  PPP
| | |
Add | Remove | Exdit I

ok I Cancel Apply
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Adding a new Remote Access Policy

You can also add multiple remote access policies on your RRAS Server. The authentication
process will become a little different with multiple policies. The order of your RAS policies
in the RRAS console will be critical to the authentication process. We will go over that after

adding a new RAS policy.

1. For now, in order for you to add a new RAS policy, just right click on Remote Access
Policies in the left pane of the RRAS console and choose New Remote Access Policy.

2. 'This will bring up the Policy Name dialog box. Just type in PPTP as the name of this

GNAL...

Tree I

Remote Access Policies

E Routing and Remote Access
Server Status

= [fay SRv-1 (local)

E Routing Intetfaces

E Remote Access Clients {0)

B Ports
- P Routing

-] Remote Access Loggin

liew 3

Expart List...

Help
—_—

Mame

| Order |

Al\nw access if dial-i

in permission is enabled 1

new policy and click Next to continue.
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Add Remote Access Policy x|

Specify a friendly name for the palicy.

A Remate sccess Policy iz 3 set of actions which can be applied to a group of users
meeting certain conditions.

Analogous bo rules you can apply to incoming mail in an e-mail application, you can
specify a set of conditions that must be matched for the Remote Access Policy to apply.
You can then specify actions to be taken when the conditions are met,

Palicy friendly narmes:
[FeTH

< Back I Next)il

Cancel
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3. In the Conditions dialog box, just click the Add button to add a condition for this new

RAS policy.

Add Remote Access Policy x|

Conditions
Determine the conditions ta match,

Specily the conditions to match.

Conditions:

Add. s || Femeve Ed. |

< Back I Nest > I Cancel

4. This will bring up to the Select Attribute dialog box.
attributes listed. Again, for this lab, you will specify the type of tunneling protocol to be
used as a condition for this new RAS policy. Select Tunnel Type and click Add.

Select the type of attribute to add, and then click the Add buttan,

Client-Friendly-Name
Client-IP-&ddress
Client-Yendar

D ay-Aind-Time-Restric. ..
Framed-Pratocol

WS- dentifier
MAS-IP-Address

Attribute types:
Mame | Diegeription
Called-Station-ld Fhone number dialed by user
Calling-5tation-1d Fhone number from which call orginated

Friendly name for the RADIUS client. (145 anly]
IP address of RADIUS client. (145 only]
Manufacturer of RADIUS prosy or MAS. (145 onl
Time periods and days of week duing which use
The protocol to be used

String identifying the MAS originating the request
IP address of the MAS originating the request (12

Type of physical port uzed by the NAS originatin
Type of service uzer has requested

Tunreling protocols to be used

‘Windows groups that user belangs to

< | i

MAS-Part-Type
Service-T

dd.. Concel |

As before, there are many

5. In this Tunnel Type dialog box, select Point-to-Point Tunneling Protocol (PPTP).
Click the Add button and the OK button to add this protocol as the required tunnel type
for the condition in this new RAS policy.
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mm_;F 2]
Available types: Selecterd s

Bay Dial Yirtual Sarv\czd Add 3> I Paint-to-Point Tunneling P
Generic Route Encaps
IP Authentication Hear << Remove

IP Encapsulating Secu
|P-inIP E ncapsulation
1P-irelP Turnneling

Laver Two Farwarding
Layer Two Tunneling F
tirimal IP-ir1P Encap:
Yilual Tunneling Froto.

el
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6. Verity the added condition and click Next to continue

Add Remote Access Policy |

Conditions
Determing the conditions to match,

Specily the candiions to match.

Canditions:

Tunnel-Type matches "'Point-to-Point Tunneling Protocol [PPTF)"

4] 2]

Add.. Remave Edt. |

cBack | Mewsp | canel |
o

7. This will bring up the Permissions dialog box. You can either grant remote access or
deny remote access if your remote users met the condition that you just added. Select
Grant remote access permission as the Permission when your users match the
condition. Click Next to continue.

Add Remote Access Policy Xl

Permizsions
Determing whether to grant or deny remote access permission.

‘You can use a Remote Access Policy either to grant certain access privieges to a
group of users, or to act as a filer and deny acoess privieges to a group of sers

If 2 uger matches the specified conditions:
@ Grant remote access permission

" Deny remote access permission

< Back I Nexl)l: I Cancel

8. On the User Profile dialog box, you can configure the profile settings for this new
remote access policy by clicking the Edit Profile button. But, for the purposes of this
lab, leave all of the settings in this remote access profile at their default settings and click
Finish to complete the addition of the remote access policy.

rad wenmie access vaicy i
User Prafie
Sipecy lhe use prolie.
ity the profbe for users wh matched the condiions you have
speced

Hobe. . e
profie can sl be used ¥ thes policy’s conditions are ovemidden on 3 peruser banis,

Fill Proke I

<Hach Fr ] Cadl |
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9. Asyou can see from the right pane of your RRAS console, you now have 2 RAS policies.
One is named Allow access if dial-in permission is enabled and the other is named
PPTP. The authentication process is going to be slightly more complicated. The
process will start by first checking your remote user’s dial-in permission in Active
Directory. The RRAS server will then evaluate the first remote access policy in the list
and determine if the remote user has either Allow access or Control access through
remote access policy as their dial-in permission.

If the condition of the first policy does not match, it will then check the next policy in
the list until the RRAS server finds a remote access policy that does match the uset’s
condition. Access will then be evaluated based on the determination of the permissions
and profile settings of that remote access policy. If the remote user does not meet all of
the conditions of any policy, then access will be denied.

In this lab, your remote user will gain access no matter what order the two remote access
policies are in. You can change the order of the policies by right clicking the PPTP
policy and click Move up to move it to the top of the list. Although this policy was set
for allowing PPTP traffic only, your default policy will always grant access to your
remote user no matter which tunneling protocol they use.

Marmne | Q... 4 |
.C\IIDW access if dial-in permission is enabled 1

Maye Do [g

Delete
Rename

Propertie=

Help
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Lab 4

Configuring a Site-to-Site VPN
for Green Lizard Books, Inc.

You will learn how to:

e Plan for a Site-to-Site VPN
e Configure the Physical Setup
e (reate Demand Dial Interfaces
e Configure Static Routes between locations
e Initiate a VPN connection between two locations
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Scenario

Over the past year, business has been going extremely well for Green Lizard Books Inc. The
owner, Bill, has opened another office in Cleveland, Ohio and he has sent his brother, Mike,
to run this new branch office. About a week ago, Bill called you up and asked you to meet
him and his brother in their Chicago office. They were looking for suggestions on how to
connect the Chicago and the Cleveland offices together. Mike informed you that their initial
plan was to set up the Cleveland network completely separate from the Chicago location and
they had even hired a computer consultant in Cleveland, Nancy, to help out with basic
administration there. After some thought was given to the subject, they have decided that
there are a lot of company documents that need to be shared between the 2 networks. Mike
would like to connect these two networks together so that users at both locations can
exchange their documents. Right away, Nancy and you came up with several ideas to
connect these networks together. The choices came down to:

1. Remote Access (dial up or VPN) — Users from the two different networks would have
to manually establish an individual connection to the remote location. This would be
cheaper up front, but would cause a lot of headaches for the users and yourself (the
administrator).

2. Leased Lines (dedicated telecommunications line between the sites) — Leased
lines would work great for this solution. However, leased lines are expensive (dependent
upon the two locations that are being connected) and they typically require contracts,
locking you in with a provider. Also, you often have to wait from 4 to 6 weeks before
they are installed.

3. Site-to-Site VPN — This solution requires some investment up front as you should have
a dedicated Internet connection (56K modems are NOT recommended) as well as a
VPN Server at each location. There are many quality VPN Server products on the
market, but a Windows 2000 solution is a good choice for Windows 2000 administrators,
because of its ease of use and integration with Active Directory.

Nancy thought that remote access was good but only when an individual user is on the road
and needs to connect to the remote network. Leased lines would be the ideal option, but
you both thought that Bill and Mike would be unhappy about the big bill each month. Since
each location has a dedicated connection to the Internet, Nancy and you agreed that a Site-
to-Site VPN would be the best solution to connect the two networks together. Nancy and
you have both planned your work and today it is time to work the plan. You will be
implementing a site to site VPN to solve Green Lizard’s problem.

In this lab, you will install a VPN server manually in the Cleveland site. You will also add
demand-dial interfaces and create static routes on both VPN servers. After this, you will
need to create VPN service accounts within Active Directory for these VPN servers,
configure their dial-in permissions and verify permissions within the remote access policy.
Finally, you will test the site to site VPN by attempting to gain access to a file in one location
from the other.
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Green Lizard Books Inc. J

Site to Site VPN Connection

VPN funnel

Router Router
i Internet
Workstations Printer
2 Windows 2000 Server Windows 2000 Server
with VPN Server with VPN Server
Chicago LAN Cleveland LAN

Green Lizard Books Inc. J

goooeouREDTy
Hub or Switch
(Acts as the Internet)

with VPN server
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In order to setup the site to site VPN, an additional computer, hub, cable and NIC is
required. Below are the computer configurations and lab diagram for this lab.

Computer
1 2 3 4
Number
Computer SRV-11 | SRV-1 SRV-12 Client-1
Name
IP Address 192.168. | Private: 192.168.1.201/24 | Private: 192.168.0.201/24 | 192.168.0.1/24
1.1/24 Public: 15.15.15.15/8 Public  15.15.15.20/8
Default 192.168. ) )
Gateway 1.201/24 Public 15.15.15.20/8 Public 15.15.15.15/8 192.168.0.201/24
Preferred 192.168. ) )
DNS server | 1.1/24 Private 192.168.1.1/24 Private 192.168.1.1/24 192.168.1.1/24
oS RS W2K Server W2K Server W2K Pro
Server
SP2 SP2 SP2 SP2

Lab Setup

Computer Mame: Sre-1
05 WaK Senver/SP2

Computer Name: Sne~-17
Static IP: 192.168.1.1/24

Default Gateway: 192, 168.1.201/24 Servicas: Saervices:
DNS: 192, 168, 1.1/24 VPN ) VPN
05 W2K Sorver/SP2 Private NIC Privata NIC

Services: Static |P: 192.166.1.201/24
Domain Gontraller DNS: 192 168.1.1/24
DNS Public NIC
Static IP: 15.15.15. 158
Default Gateway: 715.15.15.20/8
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Computer Name: Snv-12
0S: W2K Sarver’'SP2

Computer Mame: Cliant-1
Static |P: 192.168.0.1/24
Default Gateway: 192 168 0.204/24

DNS: 1892 168.1.1

Static IP: 152 168.0. 201/24
DNS: 792.168.1.1/24

Public MIC

Static IP: 15.15.15.20/8
Default Gateway: 15. 1515158

Q8 W2K Professional/SP2
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PPTP-based Site to Site VPN connection

In the pervious lab, you only have L2TP ports available on SRV-1 (the Chicago VPN server)
that are accepting VPN connections. In this lab, you will be using PPTP as the tunneling
protocol for the Site-to Site VPN connection instead. Therefore, you will need to have
PPTP ports available in your Chicago VPN server for this lab.

1. To add PPTP ports to your Chicago VPN server, you will need to log on to SRV-1, go
to Start>Programs—>Administrative Tools and click on Routing and Remote
Access. Right click Ports and select Properties. In the Ports Properties dialog box,
select WAN Miniport (PPTP) and click Configure. In the Configure Device — WAN
Miniport (PPTP) dialog box, check Remote access connections (inbound only) and
check the Demand-dial routing connections (inbound and outbound). Enter 5 as
the number of available ports and click OK once and then again on the Ports Properties
dialog box to complete the configuration. You should now have 5 PPTP ports available
for your VPN connection.

Configure Device - WAN Miniport (PPTP) 2=l

Y'ou can use this device for remote access requests or demand-dial
connections.

smote access connections [inbound anly)

emand-dial rauting connections [inbound and outbound)

Fhone number for this device: I

'ou can et a marimum port bmit for 3 device that supports multiple ports,

M asirnurn ports: IE _Ij <::|
ak. 'E I Cahicel
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Since this new Cleveland location will also be within the Green Lizard Books Inc. domain,
you will want to make SRV-12 a member server within the greenlizardbooks.com domain.
In order for SRV-12 to join the domain as a member server, a connection will have to be
established over the simulated Internet. This can be accomplished by setting up SRV-12 as a

VPN client temporarily.

1. Log on to SRV-12 and go to Start>Settings>Network and Dial-up Connections,
click on Make New Connection. This will bring up the Network Connection Wizard.
Just click Next to continue. On the Network Connection Type page, select Connect to
a private network through the Internet and click Next to continue.

Network Connection Wizard

Network Connection Type
“Y'ou can choose the type of network connection you want to create, based on
your network, configuration and your networking needs.

" Dial-up to private network
Connect using my phane line [madem or ISOM).

" Dial-up to the Internet
Connect to the Intemet using my phone line [modem or ISDON).

|:> 1+ Connect to a private network through the Internet
Create a Virtual Private Metwark [WPN] connection or tunnel’ through the Internet.

" Accept incoming connections
Let ather computers connect to ming by phone line. the Intemet, or direct cable.

" Connect directly to another computer
Connect using my senial, parallel, or infrared part,

< Back I Next)il Cancel I

2. The next screen of the wizard will ask you to enter the Destination Address. This is the
public IP address of the Chicago VPN server, 15.15.15.15. Type this IP address in and
click Next to continue.
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Network Connection Wizard

Destination Address
“Wihat is the name or address of the destination?

Type the hast name or |P address of the computer or netwark to which you are
conhechng,

st hame of dress [such as microsoft.com or 123.45.6.78).
[15.15.1514

< Back I Next » & I Cancel
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3. This will bring you to the Connection Availability screen. Select For all users and click
Next to continue. Also click Next on the Internet Connection Sharing screen and
Finish on the last screen of the wizard to complete setting up the VPN client.

Connection Availability
Yous may make the rew connsction avalsble 1o ol uees, of pait yoursel,

Vou ey ke W corrmclion avislable bo ol users, o kee il onk lor o oo uss, A
conrection sinend in pour profin vl ot be avalabln unkess you air lagged on

Cieste this cornction:
& Fo ol useis
Dk for mysok

¢ Back IW Canerd |

4. Once you are done setting up your VPN client, you will immediately get the Connect
Virtual Private Connection dialog box. Just type in administrator as the user name and
your password. Click Connect to establish the VPN connection.

Note: if you do not know the password for the administrator, just log on to SRV-11 and
reset its password in Active Directory Users and Computers.

User name:

Password I

™ Save Password

Connect ;! Cancel | Properties | Help |
L

5. After you have established the VPN connection, you need to make SRV-12 a member
server of greenlizardbooks.com.  Simply right click on the “My Computer” icon on
the desktop and select Properties. From here, select the Network identification tab,
select Properties, select domain and type in the domain name of the domain SRV-12
will join, which is greenlizardbooks.com or its NetBIOS name, greenlizardbook.
Note: NetBIOS names are a single label (no periods) up to 15 characters in length. Click
OK. It will then ask for a username and password. Use administrator as the account
name and the password from the greenlizardbooks.com domain. When it has joined
successfully, it will “welcome you to the domain™ and then tell you that it needs to restart
in order for the changes to take effect. Restart the computer and log back on to SRV-
12 after it has finished rebooting.
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Manually configuring RRAS as a VPN server on SRV12

To create a site-to-site VPN connection, not only do you need to have a VPN server at the
Chicago site, but you will also need a VPN server at the Cleveland site. As you see in the lab
setup, SRV-12 has two NICs, one of which is the public interface, directly attached to the
Internet. Therefore, SRV-12 will be the computer to configure as Cleveland’s VPN server.
For this lab, you will configure this VPN server manually (without the wizard).

1. Log on to SRV-12 and open RRAS. Right click SRV-12 and click Configure and
Enable Routing And Remote Access. This will bring up the Routing and Remote
Access Server Setup Wizard, just click Next to continue.

On the Common Configurations page, select Manually configured server to start the
server with default settings. Click Next and Finish on the last screen of the wizard to
complete the installation.
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Routing and Remote Access Server Setup Wizard

Common Configurations
Y'ou can select from several common configurations.

X

" Internet connection server
Enable all of the computers on this netwark to connect to the Internet.

" Remote access server
Enable remote computers to dial in to this network,

” Wirtual private network [VPN] server

Enable remote computers to connect to this netwark through the Intermet.

" Network router
i k_to communicate with other nebworks.

Manually configured zerver
Start the server with default settings.

< Back I Next)& I

Cancel
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PPTP Ports on the Cleveland VPN Server

There should be 128 PPTP ports available on the Cleveland VPN server by default (your
number may differ). Because the Cleveland office currently has very few users, for security
reasons, the number of ports available should be changed to reflect the maximum number of
concurrent users that will be accessing the VPN Server. Only one (1) port is needed for the
site to site connection and one port would be needed for each remote user trying to access

the VPN Server.

1. In Routing and Remote Access, right click Ports and select Properties. In the Ports
Properties dialog box, select WAN Miniport (PPTP) and click Configure.
Configure Device — WAN Miniport (PPTP) dialog box, make sure Remote access
connections (inbound only) and the Demand-dial routing connections (inbound
and outbound) are checked. Enter 5 as the number of available ports and click OK and
then OK again on the Ports Properties dialog box to complete the configuration. You

should now have 5 PPTP ports available on your Cleveland VPN server.
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Configure Device - WAN Miniport (PPTP) 2=l

Y'ou can uze thiz device for remote access requests or demand-dial
cohnechions.

smate access conhections [inbound only]

smand-dial rauting connections [inbaund and outhound]

Phone number for this device: I

'ou can et a marimunn port limit for a device that supports multiple parts,

bd asirmurn porks: IE ::II {
ak i I Cancel
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Configuring a Demand-Dial Interface on the Chicago VPN server

For a Site-to-Site VPN connection between SRV-1 (Chicago) and SRV12 (Cleveland), you
will have to configure demand-dial interfaces on both VPN servers. This interface will allow
the Chicago VPN Server to initiate a VPN session to the Cleveland VPN Server any time it

receives traffic destined

for the Cleveland network.

1. To add a new demand-dial interface on the Chicago VPN setver, log back on to SRV-1
and open Routing and Remote Access by going to Start = Programs—>

Administrative Tools>Routing and Remote Access.

In the left pane of the

console, right click on Routing Interfaces and choose New Demand-dial Interface.
This will bring up the Demand Dial Interface Wizard. Just click Next to continue.

Demand Dial Interface Wizand

i

Louting Interface:
BT Remote Access Cli
E Parts

¥~ B TP Routing

%" Remote Access Po
D Remote Access Lo

ﬂ__ Routing and Remate Access

- E server status
- ) 3RY-1 (local)

=mand-dial Intetface. .
Mevs IP Tunnel...

Wiew 3

Reftesh
Export List. ..

Help

Welcome to the Demand Dial

Interface Wizard,

et e rindre te e rouves.

Presa Hesd to confinue.

JE I

2. You should then see the Interface Name page, where you name your demand-dial
interface. Type in Chicago as the interface name and click Next to continue.
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Demand Dial Interface Wizard

Interface Name
Select the name by which this new interfface will be known,

x|

Select a name for thiz demand dial interface. & common practice is to name interfaces

alter the network or router to which they connect.

Interface name:

|Chicagu|

< Back I Next>|: I

Cancel
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3. The next screen should be the Connection Type screen, where you can either choose a
modem, ISDN adapter or VPN for this connection. Since this is going to be a VPN
connection, select Connect using virtual private networking (VPN) as the
Connection Type and click Next to continue.

Demand Dial Interface Wizard x|

Connection Type e
Select the type of demand dial interface you want to create. &.,J

" Connect using a modem, [SDM adapter, or other physical device.

' Connect uging virtual private netwarking [VPN) <:|

< Back I Nekt>F I Cancel |

4. On the VPN type page, there are 3 VPN types for you to choose from. You can choose
cither to use PPTP, L2TP or Automatic selection as the tunneling protocol. Automatic
selection will have your Chicago VPN server attempt a L2TP connection first. If the
Cleveland VPN server does not support L2TP, it will then try to use PPTP to establish
the connection. Since this is going to be a PPTP Site-to-Site VPN connection, select
Point to Point Tunneling Protocol (PPTP) as the tunneling protocol and click Next
to continue.

Demand Dial Interface Wizard =l

YPN Type S
Select the type of WPN interface you want to create. %_J

 Automatic selection

& Puoirt to Paint Tunneling Protocol [PPTF)

© Laver 2 Tunneling Protocal [L2TF)

< Back I Mext > ‘E I Cancel
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5. The next screen of the wizard will ask you to enter the destination IP address. Referring
to the lab setup, the destination address is the public IP address of your Cleveland VPN
server, which is 15.15.15.20. Type in 15.15.15.20 and click Next to continue.

Demand Dial Interface Wizard

Destination Address
‘what is the name or address of the remate router?

x|

Enter the name or [P address of the router to which you are connecting,

Hast name or dress [such as microsoft.com ar 123 45.6.78]):

|15.15.15.2t1

< Back I Next)[t I Cancel |

6. This will then bring you to the Protocols and Security screen. You can configure
transport options and security options on this screen. Check Route IP packets on this
interface for IP routing and also check Add a user account so a remote router can
dial in. The second option allows the Cleveland VPN server to connect into Chicago by
specifying a user account for it to use. Since this is going to be a two-way initiated
connection, you will also have to add another user account at the Cleveland VPN server
for the Chicago VPN server to connect into. This will be set up when you are adding a
new demand-dial interface on the Cleveland VPN server later in the lab. For now, just
click Next to continue.
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Demand Dial Interface Wizard

Protocols and Security
Select tranzports ahd security options for thiz conhection.

X

Check all that apply:
¥ Raoute IP packsts on thiz interface.
™ Raute IPX packets on thiz interface.
¥ Add a user account so a remote router can dial in.
= Send aplaintext password if that is the ol way b connect,

= Wse serpting tocamplete the connection with the remote rauter,

Cancel

< Back I Mest > |: I
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7. On the Dial in Credentials page, verify the user name, Chicago, which the Cleveland
VPN server will be using as the dial-out user account to Chicago VPN server. Leave the
password field and the confirm password field blank and click Next to continue.

Demand Dial Interface Wizard x|
Dial In Credentials i
Configure the user name and password that the remote router wil use when it disls a,l
in ko this server

‘o need to set the disl-in credentials that remate routers will use when connecting to
this interface. A user account will be created on this router with the information that you
enter here.

User name: Il:hmagg

Password: I

Confitm password |

< Back, I NEK[)& I Cancel

8. The next page is used to enter the “Dial out Credentials,” where you specify a user name
and password to be used when authenticating to the Cleveland VPN server. This dia/l-out
credential will be the same as the Cleveland dia/-in credential that you will be adding at
the Cleveland VPN server later in this lab. Type in Cleveland as the user name and
leave the rest of the fields blank. Click Next to continue. Also, make sure that you
remember this user name so that you can configure it as the dial-in credential when
configuring the Cleveland VPN server. On the last screen of the wizard, click Finish to
complete the process of adding the demand dial interface.

Demand Dial Interface Wizard x|

Demand Dial Interface Wizard x| . '
Completing the demand dial

Dial Dut Credentials - i
Carfigure the user name and password to be used when connecting b the remate . interface wizard.
router. -

To create this interface and enable it on the router, click
Finish

‘You need to set the dial out credentials that this interface will use when connecting to
the remote router. These credentials must match the dial in credentials configured on . ) )
et Ta edil this interface in the Routing and Remotedccess
Manager, select it in Routing Interfaces and press

Propetties

User name: |Cleveland

Do |

Password: |

Confirm password: |

< Back I Mext > él Cancel < Back I Finish [:I Cancel
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Configuring a static route on the Chicago VPN server

In order to allow network traffic to be forwarded from the Chicago network to the
Cleveland network, you will need to configure static routes.

1. On SRV-1, in the left pane of the Routing and Remote Access console, double click IP
routing and right click on Static Routes. Select New Static Route.

5 Routing and Remote Access

1o

J Action  Yiew |JC=' -D“l@

Tree I Static Routes

T5 Routing and Remate Access Destination | Metwork mask. | atewa,

| Inke

Server Status
=- SRy-1 {lacal)

-E Routing Interfaces

Mew Static Route. ..

+ Remote Access |
(-] Remots Access | Show IP Routing Table..

WView 3
Refresh
Export List,..

Help |

2. 'This will bring up the Static Route dialog box. First, make sure that Chicago is selected
as the interface. This is the demand-dial interface that was just created in the last step.
You must specify the Chicago interface and NOT the public interface in order for the
VPN connection to Cleveland to be established. You will also need to configure the
destination and the network mask. The destination will correspond to the Cleveland
network’s Network ID, which is 192.168.0.0. The Cleveland network’s subnet mask is
255.255.255.0, and this should be configured for the static route as well. Also, make sure
that you check the box for Use this route to initiate demand-dial connections. After
your configuration matches what you see below, Click OK to create the route.
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|nterface:
Dieztination: I 192.1688. 0 . 0

Network mask; | 255.255. 255, 0
(3 atemay:

b etric: 1 _:I

[v Use this route to initiate demand-dial connections

21 x|

QK 'E I Canicel
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Configuring a Demand-Dial Interface on the Cleveland VPN server

To set up the site to site VPN, you will also have to add a demand-dial interface on the
Cleveland VPN server.

1. Log on to SRV-12 and open Routing and Remote Access by going to
Start>Programs—> Administrative Tools>Routing and Remote Access. In the
left pane of the console, right click on Routing Interfaces and choose New Demand-
dial Interface. This will bring up the Demand Dial Interface Wizard. Click Next to

continue.
Tree I Routing Interfaces T o S| =
EHEETT LAN and Demand Dial Interf...  © | Type [ status | Connect seomepolLe Remacina
(=) Routing and Remote Access Interface Wizard,
- Server Status E&Pubhc Dedicated Enabled Connect,
=] SRY-12 (Jocal) EEPrlvate Dedicated Enabled Connect, t""“ ‘.'hm:‘;;’;:‘:""“"'“ hedecelo
Routing Interfaces - u PRI — Loopback Enabled Connect
] Demand-dial Interface...
g Forts [T —— Inkernsl Enabled Connect] oo
B Remote Access Clic
[+ 2 IP Routing Wigw 3
% Remote Access Pol
B Remake Access Lo Refresh
Export Lisk...
Help
[ Cancel
) 2| -

2. The Interface Name page is where you name the demand-dial interface. This interface
name is also used as the user account name when the Chicago VPN Server authenticates
to this server. Remember, this is the name that you set up as the dial-out credential on
the Chicago VPN server. Type in Cleveland as the interface name and click Next to
continue.

Demand Dial Interface Wizard x|
Interface Name e
Select the name by which this new interface wil be known. %

Select a name for this demand dial interface. A commaon practice is ta name interfaces
after the network or router to which they connect.

Interface name:
ICIeveIand

< Back I Mest > I Cancal
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3. This will bring you to the Connection Type screen, select Connect using virtual
private networking (VPN) as the Connection Type and click Next to continue.

Demand Dial Interface Wizard x|

Connection Type -
Select the type of demand dial interface you want to create, &J

 Cormect using a modem, ISOM adapter, or other physical device.

* Connect uzsing virtual private nebwarking [VPN] <:|

< Back I Mext > [: I Cancel |

4. On the VPN type page, once again, there are 3 VPN types for you to choose from. You
can choose either to use PPTP, L2TP or Automatic selection as the protocol type. Since
this is going to be a PPTP Site-to-Site VPN connection, just select Point to Point
Tunneling Protocol (PPTP) as the tunneling protocol and click Next to continue.

Demand Dial Interface Wizard |
YPH Type o
Select the type of WP interface pou want to create. &J

" Automatic selection

¢ Pairt ta Paint Tunneling Pratacal [PRTP)

" Layer 2 Tunneling Protocol [L2TP)

< Back I Mext > é I Cancel
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5. The next screen of the wizard will ask you to enter the Destination Address. Referring
to the lab setup, the destination address will be the public IP address of your Chicago
VPN server, which is 15.15.15.15. Type in 15.15.15.15 and click Next to continue.

Demand Dial Interface Wizard

Destination Address
‘what is the name or address of the iemote router?

x|

Enter the name ar IP addreszs of the rauter to which you are connecting.

ozt name o

ddress [such as microzoft.com or 123.45.6.78)

15.151515

< Back I Mext > [: I

Cancel |

You can configure transports

options and security options on this screen. Check Route IP packets on this interface
for IP routing and also check Add a user account to remote router can dial in.
Again, adding a user account will allow the Chicago VPN server to dial in using a
specific user account. You will be adding these user accounts for dial in at both VPN
servers because you are setting up this Site-to-Site connection as a two-way initiated
connection. Click Next to continue
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Demand Dial Interface Wizard

Protocols and Security
Select ransparts and security options for this connection.

X

Check. all that apply:
¥ Route IP packets on this interface
™ Route IP% packets an this interface.
IV Add a user account 0 a remote router can dial in
= Send & plain-test password if that is the onlyway to canmect

= Wse scripting to complete the conrection with the remote router.

< Back I Net > E I

Cancel
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7. On the Dial in Credentials screen, verify the user name, Cleveland, which the Chicago
VPN server is using as it’s dial out credential. Make sure to leave the password field and

confirm password field blank and click Next to continue.

Demand Dial Interface Wizard

Dial In Credentials

Configure the user name and password that the remote router will uze when it diaks

i to this server.

Tou need to zet the dial-in credentialz that remote rauters will use when connecting ta
thiz interface. A uger account will be created on this router with the information that you

enter here.

Uszer name:
Password:

Canfirm password:

ICIeveIand

Cancel

< Back I Next)il

8. On the Dial out Credentials page, you will specify the user name and password to be
used when connecting to the Chicago VPN server. Remember, you have already setup a
dial-in credential, Chicago, on the Chicago VPN server. In the User name field enter
Chicago and leave the rest of the fields blank. Click Next to continue. Click Finish on
the last screen of the wizard to complete the process of adding the demand dial

interface.

Demand Dial Interface Wizard

Dial Out Credentials

rauter.

Configure the user name and password to be used when connecting to the remate

Demand Dial Interface Wiza

the remate router.

User name;
Domair:
Password,

Confim password:

You need to set the dial aut credentials that this interface will use when connecting to
the remote router. These credentials must match the dial in credentials configured on

=

|Ehi:ago

Completing the demand dial
interface wizard.

To create this interface and enable it on the router, click
Finish.

To edit this interface in the Routing and Remotedccess
anager, select itin Routing Interfaces and press
Properties.

< Back I Next>&|

Cancel

< Back I Finish Fl Cancel
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Configuring a static route on the Cleveland VPN server

In order to allow network traffic to be forwarded from the Cleveland to Chicago, just like on
the Chicago VPN Server, you will need to configure a static route.

1. On SRV-12, in the left pane of the Routing and Remote Access console, double click on
IP routing and right click on Static Routes. Select New Static Route.

E Routing and Remote Access
{25 server Status
=1 [fay SRV-12 (local)

----- E Routing Interfaces

...... Skatic Ra

[]--% Remote Access P

----- E Remote Access Clisnts (0)

Mew Static Route. ..

-[_] Remote Access L

Shows IP Routing Table. ..

Refresh

Help

2. This will bring up the Static Route dialog box. Make sure that Cleveland is selected as
the interface. This demand-dial interface will be used to forward network traffic to the
Chicago site. You will also need to configure the destination and the network mask.
The destination will be the route corresponding to the Chicago network, which is
192.168.1.0. The subnet mask should be set at 255.255.255.0. Also, be sure that Use
this route to initiate demand-dial connections is checked. When your configuration
matches the screen shot below, click OK to create the Static Route.

Interface:

Static Route
M -

Destination:

Wetwork mazk:

Gateway:

|182.1EB. 1.0

|255.255.255. 1]
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v Use this route to initiate demand-dial connections

ak. & I Cancel

© Train Signal, Inc., 2002-2003



i

alr

Service Accounts for the VPN servers

dINSIGNAL,. ..

You now have to set up service accounts on each VPN Server. Service accounts are used
when a demand-dial connection is initiated and one VPN setver needs to authenticate to the

other VPN setrver.

These service accounts (one for each VPN server) are created like

normal user accounts, within Active Directory or within Local Users and groups, if your

VPN servers are not part of a domain.

1.

the Active Directory Users and

To create these two user accounts, log on to SRV-11, your domain controller, and open

Computers console to

by going

Start-> Programs—>Administrative Tools—>Active Directory Users and Computers.
In the left pane of the console, open the container named Users.

Tree I

E@ greenlizardbooks. conn
[+ Builtin
77 Computers

----- (3] Domain Controllers
D Foreign3ecurityPrincipals

Users

@ Active Directory Users and Computers [Srv-11,greenlizardbooks, com])

Users 19 ohjects
Mame | Type ;l
mDomain Compukers Security
mDomain Controllers Security
mDomain Guests Security
mDomain Users Security
mEnterprise Admins Security =
Temm Pk e ke Ciimees =y
4 ] i

New—=>User.

To create a user account, right click on the Users container in the left pane and select

| & cConsole  Window  Help

£ Active Directory Users and Computers

Trez |

|5 nctive Directory Users and Computers [Srv-L1.ar ¢

=2 greenizardbooks. com
(2] Builtin
(L Computers
{&] Domain Contrallers
{23 ForeignSecurityPrincipals

Delegate Cantral... ‘

All Tasks »

Yiew
Hew Window from Here

Refresh

Export List...

Properties

T —

1o/
=181
[ aton wew || = @[ *FE|2] 28 avEE |
Users 19 objects
Hame: Type A
€T Cert Publshers Security ¢
€72 Onsiacimins Security €
7% DrisUpdateProny Securty €
€T Domain Adming Security €
€7 Damain Computers Security €
Domain Controllers Security €
T2 Domain Guests Security €
€T Dorain Users Securty €
[d  Computer €T Enterprise Admins Security &
Cantact Group Palicy Creator Owners Security ¢
Sy Guest Lser
Frinter bt User
€TER0s and 1AS Servers Securty €
Shared Felder 1 | @F35chems Admins Security G—
Sre-1 User
TsInternetllser User S5
| sl _l’I

e
Create anew ob 2
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3. This will bring up a wizard for creating a new user. On the first screen, type in Chicago
as the first name and Chicago as the user logon name, click Next. On the next screen,
just leave the password and confirm password fields blank and click Next.

New Object - User 5[' New Object - User x|
g Create in:  greenlizardbooks.com/Users g Createin:  greenlizardbooks.com/L sers
First name: |Chicago Initials Passward ]
Last name: I Confirm pazsword. I
Chi
Il I e ™ User must change password at nest lagon

User logon name: ™ User cannot change password

[Fricago | @areenizadbooks.com =l I~ Password never expires
[~ Aecount is disabled

User logon name [prewindaws 2000)
IEHEENUZAF\DEDDK\ IEhicagn

ok [ Ness ] rencel | <Back [ Newo | cacd |

y

4. 'The final screen is just a summary of all the information that you entered in the wizard.
Confirm that the information is correct and click Finish to complete the process of
adding the Chicago VPN Service account.

New Dbject - User x|

g Cieatein.  gieenlizardbooks. comdl sers

“w/hen yau click Finish, the following object will be created

Full name: Chicago

User logon name: Chicago@greenlizardbocks, com

< Back I Finish I: I Cancel

5. From Srv-11 still, repeat these same steps within Active Directory to create a VPN
service account named Cleveland.

***Please Note***
It is very important that the account names of these VPN service accounts match the account

names that were entered when you set up the demand-dial interfaces.
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5. In order to allow remote access for both VPN service accounts, you need to configure
their dial-in permissions. Right click on Chicago in the right pane and select

Properties.
COpy...
Add members to a group...
Disable Account
Reset Password, ..
Mave, .,
Open home page
Mame # I Type I Descripkion | S]]
ﬂ Administrator ser EBuilt-in account For administering the computer f'domain
ﬁECert Publishers  Security Group ... Enterprise certification and renewal agents All Tasks 4
ﬂ Cleveland ser Delet=
ﬁEDnsndmins Security Group .., DMS Administratars Group Renams
ﬁDnsUpdatePr. .. Security Group ... DMS clients who are permitted to perform dynamic ... Refresh
@Domain Admins  Security Group .., Designated administrators of the domain
@Domain Comp... Security Group ... Al workstations and servers joined to the domain Ly
%Domain Contr,.. Security Group ... All domain controllers in the domain Help

6. This will bring you to the Chicago Properties dialog box. In the Dial-in tab, select
Control access through Remote Access Policy under Remote Access Permission
(Dial-in or VPN). You will be controlling remote access through Remote Access policy
on the Chicago RRAS server. Click OK when you are done with the configuration.
Repeat the same steps to configure the remote access permission for the Cleveland
service account as well.

Chicago Properties i |
Remate control | Terminal Services Profils

General | Address | Account | Prafile | Telephaones I Organization
Member Of Dialin I Environment I Sessiong

i Aemate Access Permission [Dialin or VPM]
" Allow access

" Deny access

c ' Control access thiough Femote Access Policy
o

™ “erify Caller!D: I

r— Callback Dptiars
% Mo Callback
" Set by Caller [Routing and Remote Access Service only

" plwaps Calback to:
I™ Assign a Static IP Address . .

T~ Apply Static Routes

Define routes to enable for this Dial-in i Flouiss |
connection.

akK I:I Cancel | Apply |
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Since control access through Remote Access Policy was specified, you will want to

make sure you grant remote access in the default remote access policy on both VPN
servers. Log on to SRV-1, your Chicago VPN server, and open Routing and Remote
Access by going to Start>Programs—>Administrative Tools>Routing and
Remote Access. Double click the default remote access policy, which will bring you
to its properties. Verify that the Grant remote access permission is set and click OK
to close the default remote access policy. Log on to SRV-12, your Cleveland VPN
server and repeat the same steps to verify the permission of the default RAS policy.

Settings

Policy name: Allow access if diakin permission is enabled

Specily the conditions to match:

Add Remove [ [ Edt. |

It & user matches the cond)

(% Grant remote access pemission

" Deny 1emate access permission

Access will bs aranted with the profile you specify, ulsss acoess
is overtidden on @ per user basis

Edit Profile.

oK Cancel

Apple

8. At this point, you have completed all of the configurations necessary for the Site-to-Site

VPN connection and it should now be functional.

To establish a Site-to-Site VPN connection, on either VPN server, right click on the
demand-dial interface and select Connect to establish the connection.

Internal

ago

Demand-dial

LAN and Demand Dial Intetfaces | Type | Skakus | Conneckion S, | Device Mame
EEPuhli[ Dedicated Enabled Connected METGEAR FAS11/FA312 PCT A, ..
E?Prlvate Dedicated Enabled Connected 3Com 3C918 Integrated Fast EE...
E?Lnnpback Loopback, Enabled Caonnected

Inkernal Enabled Caonnecked

Enabled

Disconnecked

Set Credentials. ..

Disconmect [ !

Enahle
Disable

Unreachability Reasan. ..

Set IP Demand-dial Filters
Dial-out Hours

Delete
Refrash

Properties

Help
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9. Also, since this is a demand-dial connection, a VPN session will automatically be
established as you try to access files in one site from another. In Lab 1 you created a file
named sales report in a shared folder on the domain controller, SRV-11. You can now
test access to this sales report file that you shared in the Chicago from Client-1 in

Cleveland.

To accomplish this, Log on to Client-1, double click on My Network

Places, click on the Entire Network, click on entite contents, click on the Microsoft
Windows Network, double click on the Greenlizardbooks domain, double click on
SRV-11, double click on the Sales Reports folder, double click on the sales report 03

file and you should be able to view the contents of this file.

Keep in mind that

communication is taking place across the simulated Internet and that it is encrypted.
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